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copied only in accordance with the terms of the license. All warranties given by DS SolidWorks
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Patent Notices
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Other brand or product names are trademarks or registered trademarks of their respective
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COMMERCIAL COMPUTER SOFTWARE - PROPRIETARY

The Software is a “commercial item” as that term is defined at 48 C.F.R. 2.101 (OCT 1995),
consisting of “commercial computer software” and “commercial software documentation” as
such terms are used in 48 C.F.R. 12.212 (SEPT 1995) and is provided to the U.S. Government
(a) for acquisition by or on behalf of civilian agencies, consistent with the policy set forth in
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1
SOLIDWORKS Installation and
Administration

Deploying Multiple InstallationsIndividual Installations

Installation

Creation of an administrative image that is
deployed to a number of client computers.

Installation

Installation on one or a few computers.

Licensing

License activation or network licensing.

Licensing

License activation or network licensing.

Upgrades

Moving multiple computers to a new release
by updating the administrative image used to
install on those computers.

Upgrades

Moving individual computers to a new release.

Administration

Upgrading administrative images and clients,
Network licensing administration, Workgroup
PDM vault administration.

Administration

Modifying, repairing, and removing
installations, upgrading to new releases.

SOLIDWORKS Installation Manager enables you to configure settings for SOLIDWORKS product
components, including SOLIDWORKS, SOLIDWORKS Toolbox, PhotoView 360, SOLIDWORKS
Electrical, Workgroup PDM, SOLIDWORKS PDM, and SOLIDWORKS SolidNetWork License
Manager.

SOLIDWORKS Workgroup PDM support will end after SOLIDWORKS 2017. Customers already
using SOLIDWORKS Workgroup PDM can continue to install it, but should begin planning
to migrate file vaults to SOLIDWORKS PDM Server.

SolidNetWork License Manager supports multiple license clients by distributing licenses to
clients on the network. This allows the number of users to exceed the number of licenses by
using floating licenses.

This chapter includes the following topics:
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• Individual Installation or Administrative Image
• Initiating SOLIDWORKS Installation
• Tips for Using SOLIDWORKS with Microsoft Windows 8

Individual Installation or Administrative Image
Should you install SOLIDWORKS products on each computer individually, or should you
create an administrative image and deploy the installation to all clients with one command?

If you are installing on only one computer, or if you manage dozens or hundreds of
computers, the choice is obvious. For situations in between, consider the following
comparisons.

Administrative imageIndividual installation

The system administrator can customize
multiple installations using the Option
Editor, specifying installation options such
as creating a new installation or updating
an existing one, running the installation as
an administrative user, running external
commands before or after the installation,
different product groupings, and so on.

Users can do their own SOLIDWORKS
administration.

Client computers can be distantly located
as long as they are accessible from the
same network.

The computers must be physically accessible
to the person performing the installation.

Using the Option Editor, administrative
images can maintain consistency in
versions, service packs, products, and
settings for multiple installations.

You can install different versions, service
packs, or products on different computers,
with independent settings.

A local network connection is required to
deploy the application; media drives are not
required on client computers.

Clients can be updated automatically. All
clients deployed from the same
administrative image are at the same
service pack. To maintain multiple versions,
you can create multiple administrative
images.

License activation can be automated.

An administrative image requires additional
disk space on the server; clients require the
same space as individual installations.

The computers must have network or email
access. A network or email connection is
required to activate SOLIDWORKS and
download files. Network access is also
required when collecting licenses from a
network license server.
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Initiating SOLIDWORKS Installation
You can initiate SOLIDWORKS installation from loading a DVD on the local computer,
accessing a shared installation directory, or downloading from SOLIDWORKS.

To initiate SOLIDWORKS installation, do one of the following:

• To install on a local computer from disk, insert the appropriate disk into the computer's
disk drive.

• To install from a download directory, navigate to the directory and double-click
setup.exe.

• To install by downloading from SOLIDWORKS:
a) Browse to the SOLIDWORKS Web site.
b) Login as a Subscription Service Customer, using your email address and password,
or your SOLIDWORKS serial number.

c) Under Self Service, click Download Software and Updates.
d) Under Download Software (Windows, Mac, Linux), select the SOLIDWORKS version
and service pack to download.

Tips for Using SOLIDWORKS with Microsoft Windows 8
The user interface of Windows 8 (and later) departs significantly from earlier versions of
Windows. Not only are navigation techniques different, but several methods have been
added to access key commands.

The following topics provide instructions on how to access three of the most basic functions
with Windows 8. Refer to these topics when using Windows 8 to install SOLIDWORKS.

These steps may vary depending on how yourWindows system is configured.
Consult Microsoft Windows documentation for additional instructions and
options, especially for systems later than Windows 8.

Starting SOLIDWORKS
You can start SOLIDWORKS from the Windows 8 Charm Bar and also pin SOLIDWORKS
to your desktop.

To access SOLIDWORKS from the Charm Bar:

1. From the Start screen, click in the lower right corner of the screen.

The Charm Bar displays on the right side of the screen.

You can also access the Charm Bar by pressing Windows logo+C.

2. Tap or click the Search icon.
3. Type SOLIDWORKS in the Search box and swipe down on or tap the SOLIDWORKS

tile.

You can pin SOLIDWORKS to your desktop by right-clicking the SOLIDWORKS tile and
clicking Pin to Start in the toolbar that appears at the bottom of the screen.
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Accessing the Control Panel

To access the Control Panel:

1. From the Start screen, swipe in from the right side of the screen or drag your mouse
to the top right corner of the screen.

The Charm Bar displays on the right side of the screen.

2. Tap or click the Search icon.
3. Type Control Panel in the Search box.
4. Click the Control Panel tile that appears at the left side of the Apps screen.

Accessing the Command Prompt

To access the command prompt:

1. On the Start screen, right-click to display a toolbar at the bottom of the screen.
2. On the right side of the toolbar, click All apps.
3. On the right side of the Apps screen, under Windows System, press or click

Command Prompt.

Useful Shortcuts

The following list provides helpful keyboard shortcuts:

Switch between different applications
running on your desktop.

Alt+Tab

Open the App list and Search window.Windows logo key+Q

Open a Run dialog box.Windows logo key+R

Open the Settings pane.Windows logo key+I

Consult Microsoft Windows documentation for additional instructions about keyboard
shortcuts.
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2
Individual Installations

This chapter includes the following topics:

• Installation on Individual Computers
• Administration of Individual Installations

Installation on Individual Computers
You can install SOLIDWORKS on an individual computer using several installation methods.

The SOLIDWORKS Installation Manager performs the installation, tailoring the installation
to the products you have purchased. Before you start the installation:

• Have your SOLIDWORKS serial number available.
• Verify that you have a working internet connection. The connection is required for
checking entitlement.

SOLIDWORKS Installation Manager requires various Microsoft components, including
Microsoft Windows Installer, Office Web Components, Microsoft Visual Studio Tools for
Applications, Visual Basic, and .NET Framework. If the correct versions of all Windows
prerequisite components are not installed on the computer, SOLIDWORKS Installation
Manager installs them automatically prior to installing SOLIDWORKS products. The Bonjour
service for Windows is also a required component.

If you are running Windows 8, see Tips for Using SOLIDWORKS with Microsoft Windows
8, for tasks such as accessing Start or the Control Panel. These steps may vary
depending on how Windows 8 is configured on your system. Consult Microsoft Windows
documentation for additional instructions and options, especially for systems that are
Windows 8 and later.

Summary of the ProcessInstallation Method

Insert the DVD disk into the computer disk drive.Using the SOLIDWORKS
installation media

In the download directory, double-click setup.exe.

The download directory must be accessible from the
computer on which you are installing SOLIDWORKS
products, and it must contain all of the SOLIDWORKS
installation files before installation can begin. SOLIDWORKS
Installation Manager can help you find missing files if you
have internet access and write access to the download
directory.

Using a download directory
on a server
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Summary of the ProcessInstallation Method

Do one of the following:

• In SOLIDWORKS, click Help > Check for Updates.
• In Windows, click Start > All Programs >
SOLIDWORKS Installation Manager > Check for
Updates.

You must have a working internet connection.

Workgroup PDM clients detect Vault updates
automatically. You do not need to download a service
pack to update clients. For details, see Update Clients
in the Workgroup PDM online help.

Updating an existing
SOLIDWORKS installation
using Check for Updates

1. Browse to the SOLIDWORKS Web site.
2. Login as a Subscription Service Customer, using your
email address and password, or your SOLIDWORKS
serial number.

3. Under Self Service, click Download Software and
Updates.

4. Under Download Software, click the SOLIDWORKS
version you wish to install.

You must have a working internet connection.

You must be a Subscription Service Customer with login
access to the Customer Portal site.

Downloading from the
SOLIDWORKS customer Web
site

When the installation is complete, start the SOLIDWORKS application and activate the
license.

To see a listing of the products that are installed on your machine, click Help > My
Products on the main menu in SOLIDWORKS. My Products shows you all currently
available SOLIDWORKS products. The check marks indicate the products which you or
your organization currently own based on your activation and network licenses.

Administration of Individual Installations
Typically, administration of individual installations consists of modifying, repairing,
removing, and upgrading installations.

Modifying an Installation
You can modify an installation to install products that have not been installed or to remove
products, provided that the previous installation was completed with a full set of installation
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files. This option is not available if you upgraded the previous installation with a service
pack.

If you installed SOLIDWORKS and purchased an add-in at a later time, you can modify
the installation to include the new add-in. You must install the add-in on each individual
machine.

Workgroup PDM is not installed if you are modifying your original SOLIDWORKS package
to include SOLIDWORKS Professional or SOLIDWORKS Premium.

1. Make sure no SOLIDWORKS sessions are active.
2. In Windows 7 or later, click Start > Control Panel > Programs and Features.
3. Select the SOLIDWORKS installation you want to modify and then click Change.
4. On the Welcome to the SOLIDWORKS Installation Manager screen, click Modify the

individual installation (on this computer).
5. On the Serial Number screen, verify that the appropriate serial numbers are specified.
6. On the Product Selection screen, select the products to install or remove.

When modifying an installation:

• No products are installed or removed by default, even if you specify a new serial
number. You must change the installation action of each product or feature
component.

• To view the projected action for a particular component, click the component name
(but not the check box). The intended installation action appears in the information
field below the product listing.

• You can click the check box next to the product component to change the installation
action for that component. (For example, if you are installing or removing
components, selecting the check box specifies that the component is to be installed
or removed and clearing the check box specifies that the component is not to be
installed or removed.)

• When you change a component installation action from the initial specification, an
asterisk (*) appears next to that component in the listing.

• If a component has optional installation sub-components in it, a + icon appears
next to the component. To see the available sub-components for a component,
click the + icon.

• If a component has been expanded to show optional sub-components, a - icon
appears next to the component. To collapse the sub-component listing, click the -
icon.

7. On the Summary screen, click Modify Now.
8. On the Installation is Complete screen, click Finish.

Repairing an Installation
If you encounter problems with an installed SOLIDWORKS product, you can use the
SOLIDWORKS Installation Manager to repair the installation.

However, to repair an installation, your machine must have all the source files from the
previous installation and any service packs that were applied, in the location where they
were originally installed.
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You can repair an individual installation. You cannot repair an administrative image;
you must uninstall and then reinstall the administrative image.

1. In Windows 7 or later, click Start > Control Panel > Programs > Programs and
Features.

2. Select the SOLIDWORKS version you wish to repair and click Change.
3. On the Welcome to SOLIDWORKS Installation Manager screen, click Repair the

individual installation (on this computer).
4. On the Products to Repair screen, select the product to repair.
5. Clear the rest of the products on the screen.
6. Click Repair.

Rolling Back an Individual Installation to a Previous
Service Pack

To roll back an individual installation to a previous service pack release in the current
major release family, uninstall the service pack version currently installed on the computer
and then re-install the earlier version.

Removing an Installation
You can remove an installation on an individual computer or in a client/server environment.

1. Make sure no SOLIDWORKS sessions are active.
2. If you wish to move the SOLIDWORKS license to another computer, deactivate the

license to that computer before removing the SOLIDWORKS installation on this
computer.

For more information, see Moving a License.

3. In Windows 7 or later, launch the Control Panel > Programs and Features.
4. Select the product component to remove.

In some cases, you might find multiple SOLIDWORKS Service Pack components
for a given major release version. To remove a SOLIDWORKS major release, remove
all Service Pack elements for that major release.

5. On the Uninstall screen:
a) Select the products to remove. By default, all product components are selected.
b) Clear the products that you do not want to remove.
c) Choose whether to perform a custom or complete uninstall. By default, the
SOLIDWORKS Installation Manager performs a standard uninstall and removes the
Program Files and Folders.

1. Click Change in Advanced Options.
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The Advanced Options screen appears and the Program Files and Folders option
is selected

2. Select one or more options to perform a custom uninstall, or select all options
to perform a complete uninstall.

3. Click Back to Summary.
4. On the Summary screen, expand Advanced Options to display the uninstall
method and entries.

d) Click Remove Items.

Upgrading to a New Release
There are several methods for upgrading an individual installation to a new SOLIDWORKS
release.

You can upgrade to a new release when you:

• Receive new installation media
• Are notified of upgrades when starting SOLIDWORKS
• Check for updates manually
• Start a new instance of SOLIDWORKS Installation Manager

When installing a new major release, you can upgrade a previously installed major release
or install the new release in parallel. If you are installing a Service Pack release for a
previously installed major release, that release is updated automatically.

Checking for Updates Manually
You can check for updates for a currently installed SOLIDWORKS release using one of
these methods.

• In SOLIDWORKS, click Help > Check for Updates.
• In Microsoft Windows, click Start > All Programs > SOLIDWORKS Installation
Manager > Check for Updates.

Upgrading Workgroup PDM Clients
Clients are prompted to update the first time they log in after the vault is updated. No
service pack is required for client updates.

ActionClient Status Relative to Vault

NoneSame version as vault

NoneSame major release, newer than vault

Login is blockedNewer major release, newer than vault

Optional updateSame major release, older than vault

Mandatory updateOlder major release, older than vault
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For details about updating Workgroup PDM clients, see Update Clients in the Workgroup
PDM Help.

Upgrade Caveats
Products that can have multiple installations with different major versions do not always
support major upgrades, or the ability to upgrade between major versions as a single
operation.

In this case, SOLIDWORKS Installation Manager simulates the upgrade by first installing
the new version, then removing the old one. At this time, the core SOLIDWORKS product
supports major upgrades, while the other products do not.

The consequences of this are:

• When upgrading the core SOLIDWORKS product between major versions:

• Your existing installed location does not change.
• The upgrade can be rolled back if an error occurs or the you cancel during the
upgrade.

• When other products are upgraded between major versions:

• Each product is first installed as a new product to a new location, then the original
installation is removed.

• Once started, the upgrade cannot be rolled back if an error occurs or if you cancel
during the upgrade.

Product Coexistence Rules
These product coexistence rules determine how new products are installed and existing
products are upgraded.

ExamplesRule

SOLIDWORKS 2015 SP3.0 and
SOLIDWORKS 2016 SP0.0 can coexist on
the same computer.

Multiple major release versions of the core
SOLIDWORKS product are allowed, with the
exception of the products mentioned below.

SOLIDWORKS 2016 SP0.0 and 2016 SP1.0
cannot coexist on the same computer. If
you install SOLIDWORKS 2016 SP1.0 on a
computer where SOLIDWORKS 2016 SP0.0
is already installed, SOLIDWORKS
Installation Manager will replace SP0.0 with
SP1.0.

Multiple service packs from the same major
release version are not allowed.

If SOLIDWORKS 2016 SP0.0 is installed,
Workgroup PDM Server is upgraded to 2016
SP0.0, even if an earlier major release of
SOLIDWORKS remains on the computer.

Only one version of the following products
is allowed on the computer:

• Workgroup PDM Server
• SolidNetWork License Manager
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ExamplesRule

If you install SOLIDWORKS 2016 SP0.0 or
SP1.0, you should also upgrade to
SOLIDWORKS 2016 PDM Server and PDM
Client.

If you install SOLIDWORKS 2016 PDM
Server, you should use the PDM Server
installation process to install the
SOLIDWORKS PDM Client. Do not install the
SOLIDWORKS PDM Client separately with
the client installation process.

SOLIDWORKS PDM Client must be the same
release version and service pack as
SOLIDWORKS PDM Server on the same
machine.

See Installing a PDM Server with SLDIM
topic for more information.

Only one version of the following products
is allowed on the computer:

• SOLIDWORKS PDM Client
• SOLIDWORKS PDM Server

If SOLIDWORKS 2016 SP0.0 is upgraded to
2016 SP1.0, SOLIDWORKS Explorer 2016
SP0.0 will automatically be upgraded to
2016 SP1.0. However, SOLIDWORKS
Explorer 2015 SP4.0 can coexist with
SOLIDWORKS Explorer 2016 SP0.0 or with
SOLIDWORKS Explorer 2016 SP1.0.

Only one version of an included product can
be installed for any major release version
of SOLIDWORKS. However, versions of
included products from different major
release versions of SOLIDWORKS can
coexist.

You must have administrative permissions to run more than one major version of
SOLIDWORKS on the same machine.
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3
Multiple Installations

This chapter includes the following topics:

• Deploying to Multiple Clients
• Using Administrative Images
• Deploying an Administrative Image to Clients Through Email
• Command-Line Deployment
• Administration of Multiple Installations

Deploying to Multiple Clients
You can install the SOLIDWORKS product on multiple clients by creating an administrative
image and then deploying the installation to clients.

The process for deploying to multiple clients is:

1. Create an administrative image.

• Creating an Administrative Image from SOLIDWORKS Installation Manager
on page 20

2. Deploy the administrative image to clients.

• Deploying an Administrative Image to Clients Through Email on page 33
• Installing from the Administrative Image Using the Command Line on page
42

3. Implement licensing.
• Administering Individual Licenses on page 85
• Administering Licenses Using a SolidNetWork License Manager on page 86

If you are running Windows 8, see Tips for Using SOLIDWORKS with Microsoft Windows
8, for tasks such as accessing Start or the Control Panel. These steps may vary
depending on how Windows 8 is configured on your system. Consult Microsoft Windows
documentation for additional instructions and options.

Using Administrative Images
An administrative image allows configurable installations of SOLIDWORKS products from
a single network location.

You can install the administrative image from any computer on the network, including a
client computer.
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• The administrative image must be in a shared folder.
• If you include all products, the administrative image disk space requirements can be
7GB or more.

• If you update the share name when you upgrade the administrative image, the client
upgrades automatically the next time the application is started. For details, see
Upgrading Clients from Administrative Images.

• Clients must have administrative privileges on their computers. If clients have insufficient
privileges, an alternate method is available to install images.

Once you have created an administrative image, the Administrative Image Option Editor
can manage installation option settings for users and groups installing from that image.
For details, see Administrative Image Option Editor.

Creating an Administrative Image from SOLIDWORKS
Installation Manager
If you are installing SOLIDWORKS on multiple computers, you can create an administrative
image and then deploy the application to other computers.

1. Start SOLIDWORKS Installation Manager. See Initiating SOLIDWORKS Installation.
2. On the Welcome screen, select Administrative image.

Administrative image creation options appear.

DescriptionOption

Create the image using the default configuration
settings (that is, not based on the settings currently
established for an existing administrative image at
your site

Create a new image using
default settings.

Create the image using configuration settings
specified for an existing administrative image at your
site. Click Browse to specify the installation directory
for the existing administrative image.

Create a new image using
settings and files from an
existing image.

3. Follow the on-screen instructions.

Administrative Image Option Editor
The Administrative Image Option Editor lets you customize installation parameter settings
in an administrative image for individual machines and for groups of machines.

After creating an administrative image, SOLIDWORKS Installation Manager asks you to
start the Option Editor. You can also start the Option Editor by double-clicking
sldAdminOptionEditor.exe in the administrative image folder.

To specify different installation configurations for groups of machines or individual
machines, in the Option Editor select machines by machine name, IP address, or IP
address range, then specify the installation options for those machines.
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All dialog boxes, that prompt for a file or folder path, include an option where you can
assign a selected folder to an environment variable. For example, if you select C:\
Program Files\SOLIDWORKS Corp, the file path is mapped to %ProgramFiles%\
SOLIDWORKS Corp. The most common variables are %ProgramFiles% and
%SystemDrive%.

You cannot convert all paths into environment variables. For example, Z:\SOLIDWORKS
Data cannot be mapped to an appropriate environment variable.

Adding and Deleting Groups and Machines
The Administrative Image Option Editor lets you specify different installation configurations
for groups of machines and for individual machines.

For example, you might want to configure several machines to use a particular subset of
the product components available in the image while another group might use a different
subset of product components. Even though you are using one administrative image, the
Option Editor group settings enable you to install different product subsets to different
groups of machines.
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1. Right-click Global Settings and then click Add Group.
2. Enter the group name.

To add a group:

1. Right-click an existing group or Global Settings and then click
Add Machine.

If you right-click an existing group, machines are added to
that group. Otherwise, they are added at the top level.

2. Do one of the following:

• Select By Machine Name and enter one or more machine
names. Multiple machines can be separated by a line break,
space, tab, comma, period, colon, or semi-colon. You can
copy and paste a list of machine names from an external file.
Machine names cannot include domain qualifiers. For
example, pluto.solidworks.com is invalid.

• Select By IP Address and enter the IP address of a machine.
• Select By IP Address Range and enter the starting IP
address and the ending IP address of the range.

• Click Add Multiple Machines to select machines from the
network.

To add machines:

Drag the machine onto the group.To move an
existing machine
to a group:

Drag the machine onto Global Settings or onto a different group.Tomove amachine
out of a group:

Right-click the group or machine and then click Delete Group or
Delete Machine.

If you delete a group, all machines within that group are
deleted.

To delete a group
or machine:

Right-click Global Settings and then click Delete All.To delete all
groups and
machines:

Viewing and Editing Option Settings
SOLIDWORKS Administrative Image Option Editor enables you to view and change option
settings for groups and machines specified for the image.

• When you first start the Option Editor, option settings are displayed in read-only mode.
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The Edit icon is not shaded.

Clicking on Global Settings, a group, or a machine displays a summary of option
settings for that item:

Option Settings DisplayedScope

All option settings specified for the administrative imageGlobal Settings

Changes in the group settings relative to the Global SettingsGroup

Changes in the machine settings relative to the groupMachine

• To make changes to option settings, click on the Edit icon. The icon becomes shaded
and a more detailed option settings listing appears.

Clicking on Global Settings, a group, or a machine lets you change option settings
for that item. When you make a change in an option setting that differs from the
inherited Global Settings or group settings, that option setting is highlighted.

If you click the Edit icon again, the display reverts to read-only mode.

If you make changes, the Option Editor prompts you to save or discard them when
you exit.

Specifying Option Settings for Groups and Machines
You can specify option settings for all machines (Global Settings), groups of machines,
and individual machines.

1. In the Option Editor, click the object to modify (Global Settings, a group, or a
machine).

2. On the right, click the Edit icon.
The Edit icon becomes shaded and a more detailed option settings listing appears.

3. Make option setting changes by clicking option settings on the right for the item
selected on the left.
Changes in option settings that override Global Settings or group settings are
highlighted.

4. Click OK or Close to save your changes.

DescriptionOption

The Option Editor saves your changes and exits.OK

The Option Editor asks if you want to save your changes and
then exits.

Close
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Administrative Image Option Settings
The Option Editor enables you to specify option settings for individual clients or groups,
including serial numbers, client installation options, which software components to be
installed, and toolbox location.

Serial Numbers

Enter the serial numbers for products to be installed on client machines.

Because there are multiple ways to purchase SOLIDWORKS products, some serial
numbers can cover two or more products. For example, a SOLIDWORKS serial number
might enable you to install SOLIDWORKS Simulation without entering a separate
SOLIDWORKS Simulation serial number. In addition, some products do not require a
serial number. If you have any questions about your serial numbers, contact your VAR.

If you are managing licensing using SolidNetWork Licensing:

• In the first serial number field, enter the SolidNetWork serial number.
• In the SNL Server port@server field, enter the SolidNetWork License Manager server
name and port in the form nnnnn@servername. Separate multiple entries using
semicolons.

For details about SolidNetWork licensing, see Installing and Configuring SolidNetWork
Licensing.

Client Installation Options

You can specify how client installations handle an existing prior
major version installation:

• Upgrade an existing major version (if one exists).

Specify this option to replace the prior major version installation
with the new version installation

• Create a new major version.

Specify this option to keep the prior major version and create
a new installation for the new major version. To specify a
location for the new version installation, click Browse.

How do you want to
perform client
installations of major
versions?

You can specify whether to uninstall the existing prior major
version installation:

• No, do not uninstall first.

Specify this option to retain the prior major version installation.
• Yes, perform a custom uninstall.

Select this option to remove these items: Programs Files and
Folders, Registry Entries, Data Files and Folders.

Do you want to
uninstall the most
recent previous
version before
installing a new
major version?
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You can specify that client installations configure SOLIDWORKS
settings based on the SOLIDWORKS settings configured on the
client machine or SOLIDWORKS settings exported from the Copy
Settings Wizard. The Copy Settings Wizard saves, restores, and
propagates system settings to users, computers, or profiles.

You can launch the Copy Settings Wizard from the Tools >
Save/Restore Settings in the SOLIDWORKS software or click
Start > All Programs > SOLIDWORKS version >

SOLIDWORKS Tools > Copy Settings Wizard .

Selecting Tools > Save/Restore Settings runs the Copy
Settings Wizard in a special mode which allows the
SOLIDWORKS software to remain up and running, while you
save or restore your current user settings.

• Use current settings (if they exist) or use SOLIDWORKS
default settings

If the client machine has defined SOLIDWORKS settings, keep
those settings. (For any settings that are not specifically defined
on the client, the client installation uses the default
SOLIDWORKS settings.)

• Use a settings file exported from the Copy Settings
Wizard.

Selecting this option setting enables you to specify option
settings from an existing Copy Settings Wizard export file.
(Typically, this file is named solidworkssettings.sldreg.)
Click Browse to find an existing settings file, or New to start
the Copy Settings Wizard to create a new settings file.

For more information, see SOLIDWORKS Help.

How do you want to
apply SOLIDWORKS
Settings?
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You can specify whether to complete product activation
automatically after running the installation, or require that the
user perform product activation manually after installation.

If you specify automatic product activation, the
administrative image must be available through the
shared network location the first time clients run
SOLIDWORKS after the installation. If the administrative
image is unavailable to clients that installed from that
image, those clients will not be able to complete the
automatic product activation. They will not be able to
run SOLIDWORKS unless they run SOLIDWORKSProduct
Activation manually.

• Activate automatically when each client installation
completes.

Selecting this option setting specifies that product activation
runs automatically using a SOLIDWORKS Product Activation
file. (Typically, this file is named AutoActivation.xml.) Click
Browse to find an existing activation file, or New to start
SOLIDWORKS Product Activation to create a new activation file.

• Do not activate automatically.

Selecting this option setting specifies that no automated product
activation occurs. The client user performs product activation
after installation.

How do you want to
activate client
installations?

Administrative Options

A client installation can create a diagnostic log that can be
used to troubleshoot installation problems. Creating this
log can make the client installation run slower.

Create a diagnostic log
during each installation.

A client installation can run as a different user only if the
User Account Control (UAC) is disabled. This option can be
useful when individual users do not have local
administrative permissions on their machines (which is
required to install SOLIDWORKS products).

An alternate method of deployment and installation is
available when clients do not have administrative
privileges. See Deploying Installations from the Option
Editor.

Run the installation as a
different user.

You can specify that a custom program runs before or after
the client installation.

Run a program before or
after installation.
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You can specify that client machines participate in the
SOLIDWORKS Customer Experience Program. Performance
information is sent to SOLIDWORKS Corporation to help
improve the product. The process is transparent and
confidential. For details, see Customer Experience
Improvement Program Web site.

Do you want clients to
participate in the
SOLIDWORKS Customer
Experience Program?

Limitations on the Run a Program Before and After Installation Options

These options allow you to run other installation programs or scripts on the client machines
before or after deploying SolidWorks, for example a script that installs Microsoft Office.

If you are deploying automatically to Windows 8 client machines, there is a limitation on
using these options. A failure occurs if you use either option to deploy an installation
program or script that displays a user interface, for example a script that displays dialog
boxes. When the automatic deployment of SOLIDWORKS runs, it will fail to install
SOLIDWORKS on the target machines. This limitation does not occur with Windows 7
client machines.

To use the Run a program before installation and Run a program after installation
options, you should only select programs that can be installed in silent mode.

Software to Install

You can specify what SOLIDWORKS product components to install.

• Selecting the check box next to the product component specifies that the component
is installed during the client installation.

• Clearing the check box specifies that the component is not installed.
• If a component has optional installation sub-components in it, a + icon appears next
to the component. To see the available sub-components for a component, click the +
icon.

• If a component has been expanded to show optional sub-components, a - icon appears
next to the component. To collapse the sub-component listing, click the - icon.

The Languages specification limits the languages that are installed for the
SOLIDWORKS product only. Other product installations are not affected by this
specification. For example, eDrawings®, SOLIDWORKS Workgroup PDM, and
SOLIDWORKS Explorer install all languages.

Toolbox Options

You can specify which standards to support and the default Toolbox location for client
installations.

It is common to have multiple users accessing a shared Toolbox, typically through a
network location (for example, a UNC path, a shared folder, or a common network drive
specification).

If the location contains an older major version of Toolbox, the client installation will
upgrade that Toolbox to the new major version. The files will no longer be compatible
with previous major versions of SOLIDWORKS.
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If you want to retain the Toolbox for the older SOLIDWORKS version (for
example, if some clients might continue using the older version), you must
specify a different Toolbox network location for clients that are upgrading
to the newer version.

For details about SOLIDWORKS Toolbox administration, see the Toolbox information in
SOLIDWORKS Help.

SOLIDWORKS PDM Client Options

You can select the following options for deploying SOLIDWORKS PDM clients and add-ins:

• PDM product type
• PDM client type
• Features

See the section on SOLIDWORKS PDM for more information about these clients and
add-ins.

Electrical Options

You can specify the following parameters for the administrative components of
SOLIDWORKS Electrical:

• Data path
• Collaborative Server machine name and port number
• SQL Server machine name and password

See the section on SOLIDWORKS Electrical for more information about these components.

Inheritance of Global and Group Option Settings
Option settings for Global Settings or groups are inherited by items underneath them.

For example:

• Settings defined for Global Settings are inherited by all groups and machines.
• Settings defined for a group are inherited by all machines within that group.

You can change option settings for a machine or group to override default or inherited
settings. When you change an option setting from the default or its inherited value, that
option is highlighted.

To revert option settings to the original inherited values, right-click the group or machine
and then click Revert to Global Settings (for a group or machine that is not a group
member) or Revert to Group Settings (for a machine that is a group member).

Customize Settings for Each Machine
You can also modify settings that you have applied to specific machines by right clicking
the machine name.

From the shortcut menu, you can do the following tasks for each machine:

• Delete the machine from the editor
• Revert to global settings
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• Add or edit notes
• Edit options

Edit options allows you to modify all of the options for the machine, such as the client
installation options and the administrative options.

Deploying Installations from the Option Editor
You can deploy installations directly from the Option Editor by using either a manual or
push method.

• Use the Deploy Manually page of the Option Editor to email instructions to users on
how to start the installation. Use this method when users have administrative privileges
for their client machines.

• Use the Deploy Automatically page of the Option Editor to push installations
automatically to target machines. Custom uninstalls can also be performed. Use this
method when users do not have administrative privileges to install software on their
systems.

To use either method, you must change the administrative image installation directory
to a Windows shared directory, so it is available through a network location (for example,
\\machine\shared_directory or copy the whole image to a local directory on each
machine, such as C:\SOLIDWORKS Admin\SOLIDWORKS 2015 SP0).

Using a Mapped Drive to Deploy an Administrative Image
A UNC path (\\machine_name\share_name) is the recommended method for specifying
a network location for the administrative image installation directory. However, you can
use a mapped drive as the location for the StartSWInstall.hta file in the administrative
image (for example, U:\StartSWInstall.hta), provided the installing users all have that
same drive letter mapped to the administrative image shared directory.

For example, if you mapped the U: drive to the administrative image shared directory,
the notification email will instruct the users to click a link to file://U:\
StartSWIOnstall.hta. Users receiving the email can successfully install provided that
the U: drive is mapped to the UNC location for the administrative image (\\machine_name\
share_name).

Using StartSWInstall.exe to Deploy an Administrative Image

You can install or uninstall an administrative image on clients by running the command
admin_image_install_dir\StartSWInstall.exe. This method installs SOLIDWORKS using
the options, machines and groups defined in the Administrative Image Option Editor.

You can append the following switches to the StartSWInstall.exe command:

Installs the administrative image on client
machines.

/install
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Uninstalls the software from client
machines, with two optional switches:

Available for uninstall only.
Removes SOLIDWORKS data
files and folders during
uninstall.

/removedata

Available for uninstall
only. Removes
SOLIDWORKS registry
entries during uninstall.

/removeregistry

/uninstall

Displays a progress window for the
SOLIDWORKS Installation Manager.
Otherwise the SOLIDWORKS Installation
Manager is hidden from the user.

/showui

Starts the install or uninstall immediately.
The 5 minute warning dialog box does not
appear.

/now

StartSWInstall.exe is preferred to using StartSWInstall.hta in cases where you want
the installation to proceed without any user interaction, but do not want to use automatic
deployment from the Administrative Image Option Editor.

Deploying Manually
Use this method if users have the privileges required to install on their systems.

To deploy installations manually using email:

1. In the Option Editor, click Deploy.
Installation availability and status for each machine appears.

2. Click Send Email.
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3. Specify the network path to the administrative image installation directory.
Typically, the directory path to the administrative image installation directory is shown
initially as a Windows file path (for example, C:\SOLIDWORKS Admin\SOLIDWORKS
2015 SP0). The dialog box indicates This path is not a network path.
a) Click Browse to specify the network location for this administrative image
installation directory.

b) Navigate to the computer where the administrative image is installed, and select
the Windows shared directory specified for the administrative image installation
directory.

Do not navigate inside the administrative image shared directory (for
example, into the 64bit subdirectories).

c) Click OK.
The dialog box indicates This path is a network path.

An email is created to instruct the machine owner how to install from the administrative
image using the network location for the StartSWInstall.hta file in the administrative
image.

4. Send the email to the users responsible for installing SOLIDWORKS.

Users can double-click the link to the network location for StartSWInstall.hta in the
email to install SOLIDWORKS from the administrative image.

In the Option Editor, Installation Status shows:

The user has not yet run the installation on this machine.Pending

The user successfully completed the installation on this machine.Successful

The user ran the installation on this machine, but it failed.Failed

Other status messages that might display are: Installed Successfully, Uninstalled
Successfully, Installing, Uninstalling, Requires Reboot, Install Failed, and Uninstall Failed.

Prerequisites for Deploying Automatically
With automatic deployment, installation tasks are pushed to target machines and carried
out by the Microsoft Task Scheduler on each system, without requiring any actions by
users. Use this method when users do not have administrative privileges to install software
on their systems.

With a push installation, the Task Scheduler launches SOLIDWORKS Installation Manager
to run under credentials specified by you, the administrator. The Task Scheduler runs
under the computer's LocalSystem account. This account is represented on the network
as a computer security principle. The computer security principle must have read access
to the shared folder where the administrative image is located.

In Active Directory, when you add a computer to a group of a shared folder, select Object
Types and make sure that Computers is selected.

In addition, the computer serving the administrative image and the target client machines
must be members of the same Active Directory domain.
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Deploying Automatically

To deploy automatically by pushing installations to user systems:

1. In the Option Editor, click the Deploy Automatically tab.
Installation availability and status for each machine appears.

2. Under the Deploy column, select the target client machines and groups in the Deploy
column.

You must select one or more machines or groups under the Deploy column before
initiating the deployment process.

3. Under Install Time, select Now to deploy immediately or Later to schedule a specific
date and time for the deployment.

4. Under Client Options, select from the following:

• Install or Upgrade SOLIDWORKS 2015
• Uninstall SOLIDWORKS 2015

If you select to uninstall, you can specify whether to uninstall registry entries
and data files and folders along with the program files and folders.

5. Select Reboot computer automatically if you want the target machine(s) to reboot
when the deployment is complete.

6. Enter the Client Credentials of the target machine(s).
7. Click Deploy to initiate the deployment process.

In the Option Editor, Installation Status shows:

The installation has not yet run on this machine.Pending

The installation successfully completed on this machine.Successful

The installation on this machine failed.Failed

Other status messages that might display are: Installed Successfully, Uninstalled
Successfully, Scheduling, Connecting, Installing, Uninstalling, Requires Reboot, Install
Scheduled, Uninstall Scheduled, Install Failed, Uninstall Failed, Connection Failed, and
Scheduling Failed.

Exiting the Option Editor
You can click OK or Close to exit the Option Editor.

Click OK, Close, or use the Windows application Close button to apply changes and
exit the Option Editor.

• Click OK to apply any option setting changes and exit the Option Editor.
• Click Close to exit the Option Editor.
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If there are changes to be applied, you are asked whether you want to save those
changes.

• Click the Windows application Close button (X). If there are changes to be applied,
you are asked whether you want to save those changes.

Creating a Desktop Shortcut to the Option Editor
You can create a Windows desktop shortcut to the Option Editor for a particular
Administrative Image from within the application.

1. Start the Option Editor.
For example, in Windows Explorer, navigate to the administrative image installation
directory and double-click sldAdminOptionEditor.exe.

2. Click Create Desktop Shortcut to this Option Editor.
A shortcut to the Option Editor for the administrative image appears on the Windows
desktop.

Deploying an Administrative Image to Clients Through Email
Once you have created a shared administrative image directory, you can notify clients
by email.

Configure the administrative image directory to be shared on a machine that is accessible
to other computers (for example, through a UNC path).

You can send an email containing a link to admin_image_install_dir\
StartSWInstall.hta to all clients. Clients then can click this link and then click Install
SOLIDWORKS products now to start the installation from the administrative image.

If you are upgrading an administrative image to a new SOLIDWORKS version, you can
configure your administrative image location and share properties so that any clients
that installed previously using that image will upgrade automatically. For details, see
Upgrading Clients from Administrative Images.

Command-Line Deployment
You can automatically deploy an administrative image using a command prompt or batch
file (silent installation).

To deploy an administrative image using the command line for SOLIDWORKS PDM
clients, see the SOLIDWORKS PDM Installation Guide.
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Preparing Clients for Command-Line Installation from an
Administrative Image
After creating the administrative image and before notifying clients, you must install
Microsoft Windows components that cannot be installed by administrative images created
using the command line or Microsoft Active Directory.

Installing these Windows components manually is required only if you are installing
from an administrative image using the command line or through Microsoft Active
Directory. If you use SOLIDWORKS Installation Manager to create and install the
administrative image, these Windows components are installed automatically.

Here is a summary of the files required by SOLIDWORKS in the Windows components:

Contains COM controls that are needed for
DriveWorks.

Office Web Components

Contains runtime components for Microsoft
Visual C++.

The 2005, 2008, 2010, and 2012 versions
must be installed.

Visual C++ 2005, 2008, 2010, and 2012
Redistributable Package

Provides support for Visual Basic macros.Visual Basic for Applications 7.1

Contains a tool set supporting Visual Studio
applications.

As of SOLIDWORKS 2013, installing
Microsoft Visual Studio Tools for
Applications (VSTA) is optional.

VSTA is dependent on Microsoft .NET
Framework 3.5 being installed on your
computer.

For Windows 7 and later, .NET
Framework is a feature of the operating
system.

If you need to install .NET Framework
3.5, it is available on your Windows
media and on the internet. If you cannot
locate your Windows media, do not have
an internet connection, or do not have
permission to install Microsoft .NET
Framework 3.5 on your computer,
contact your Administrator for assistance.

Visual Studio Tools for Applications

Provides a debugging environment for 64-bit
operating systems.

Visual Studio Remote Debugger
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Contains the common language runtime and
.NET Framework components that are
necessary to run .NET Framework 4.5
applications.

.NET Framework 4.5

Provides the ability to discover services on
a local area network.

Bonjour service for Windows

Visual C++ Redistributable Package and .NET Framework 4.5 are required for all
SOLIDWORKS products, not just the core SOLIDWORKS product.

These components must be included in subdirectories of the administrative image directory.

The following tables identify the specific files that are required for each supported operating
system.

Operating System: Windows Server 2008 R2 64-bit

SOLIDWORKS Media: 64-bit version for Windows 7

Installation on Windows Server 2008 R2 or Windows Server 2012 and 2012 R2 is
supported for SOLIDWORKS PDM Server, Workgroup PDM Server and SOLIDWORKS
SolidNetWork License manager.

(Not applicable)Windows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2005 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2008 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2010 Redistributable Package:
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Operating System: Windows Server 2008 R2 64-bit

SOLIDWORKS Media: 64-bit version for Windows 7

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2012 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:
(optional)

If VSTA is installed, .NET 3.5 Framework (dotnetfx35.exe) is required.

For Windows 7, .NET Framework 3.5 is a feature of the operating system.

rdbgexp.msiVisual Studio Remote Debugger:

vba71.msiVisual Basic 7.1:

.netfx45_full_x86_x64.exe.NET Framework 4.5:

bonjour64.msiBonjour service for Windows:

Operating System: Windows Server 2012 and 2012 R2 64-bit

SOLIDWORKS Media: 64-bit version for Windows 7

Installation on Windows Server 2008 R2 or Windows Server 2012 and 2012 R2 is
supported for SOLIDWORKS PDM Server, Workgroup PDM Server and SOLIDWORKS
SolidNetWork License manager.

(Not applicable)Windows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2005 Redistributable Package:
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Operating System: Windows Server 2012 and 2012 R2 64-bit

SOLIDWORKS Media: 64-bit version for Windows 7

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2008 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2010 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2012 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:
(optional)

If VSTA is installed, .NET 3.5 Framework (dotnetfx35.exe) is required.

For Windows 7, .NET Framework 3.5 is a feature of the operating system.

rdbgexp.msiVisual Studio Remote Debugger:

vba71.msiVisual Basic 7.1:

.netfx45_full_x86_x64.exe.NET Framework 4.5:

bonjour64.msiBonjour service for Windows:

Operating System: Windows Server 2012 and Windows Server 2012 R2 64-bit

SOLIDWORKS Media: 64-bit version for Windows 8 and 8.1

Installation on Windows Server 2008 R2 or Windows Server 2012 and 2012 R2 is
supported for SOLIDWORKS PDM Server, Workgroup PDM Server and SOLIDWORKS
SolidNetWork License manager.

(Not applicable)Windows Installer:

37

Multiple Installations



Operating System: Windows Server 2012 and Windows Server 2012 R2 64-bit

SOLIDWORKS Media: 64-bit version for Windows 8 and 8.1

owc11.exeOffice Web Components:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2005 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2008 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2010 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 20102 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:
(optional)

If VSTA is installed, .NET 3.5 Framework (dotnetfx35.exe) is required.

For Windows 8, .NET Framework 3.5 is a feature of the operating system.

rdbgexp.msiVisual Studio Remote Debugger:

vba71.msiVisual Basic 7.1:

.NET 4.5 is part of the operating system,
which fulfills this requirement.

.NET Framework 4.5:

bonjour64.msiBonjour service for Windows:
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Operating System: Windows 7 64-bit

SOLIDWORKS Media: 64-bit version for Windows 7

(Not applicable)Windows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2005 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2008 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2010 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2012 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:
(optional)

If VSTA is installed, .NET 3.5 Framework (dotnetfx35.exe) is required.

For Windows 7, .NET Framework 3.5 is a feature of the operating system.

rdbgexp.msiVisual Studio Remote Debugger:

vba71.msiVisual Basic 7.1:

.netfx45_full_x86_x64.exe.NET Framework 4.5:

bonjour64.msiBonjour service for Windows:
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Operating System: Windows 8 and 8.1 64-bit

SOLIDWORKS Media: 64-bit version for Windows 8

(Not applicable)Windows Installer:

owc11.exeOffice Web Components:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2005 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2008 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2010 Redistributable Package:

vcredist_x86.exe

vcredist_x64.exe

Both must be installed.

Visual C++ 2012 Redistributable Package:

vsta_aide.msiVisual Studio Tools for Applications:
(optional)

If VSTA is installed, .NET 3.5 Framework (dotnetfx35.exe) is required.

For Windows 7, .NET Framework 3.5 is a feature of the operating system.

rdbgexp.msiVisual Studio Remote Debugger:

vba71.msiVisual Basic 7.1:

.NET 4.5 is part of the operating system,
which fulfills this requirement.

.NET Framework 4.5:

bonjour64.msiBonjour service for Windows:
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InstallingWindows Prerequisites from the Command Line on 64-bit
Operating Systems
Follow this process to install Windows prerequisites for administrative image installation
using the command line on 64-bit versions of Windows.

To install multiple components in one install operation, create a batch file with the
commands provided in the following procedures and use it to push the components to
the client computers.

1. Ensure that the target computer has at least 620 MB of available disk space and a
valid TEMP directory.

2. Install Office Web Components by running this command:
administrative_image_directory\OfficeWeb_11\owc11.exe/quiet

3. Install the Visual C++ RELEASE Redistributable Package.

Install the package for RELEASE = 2005, 2008, 2010, and 2012.

administrative_image_directory\Microsoft_C++_RELEASE_Redistributable_(x64)\vcredist_x64.exe
/Q

administrative_image_directory\Microsoft_C++_RELEASE_Redistributable\vcredist_x86.exe
/Q

You must install both the 32-bit and the 64-bit versions of this package.

For example, to install the Visual C++ 2005 Redistributable Package, use:
• administrative_image_directory\Microsoft_C++_2005_Redistributable_(x64)\vcredist_x64.exe
/Q

• administrative_image_directory\Microsoft_C++_2005_Redistributable\vcredist_x86.exe
/Q

4. Install Microsoft .NET Framework 4.5:
administrative_image_directory\.Net_Framework_4.5\dotnetfx45_full_x86_x64.exe

5. Install the Visual Studio Tools for Applications:
administrative_image_directory\Microsoft_VSTA\vsta_aide.msi

If installing VSTA, .NET Framework 3.5 is required.

For Windows 7 or later, the .NET Framework 3 is a feature of the operating system.

6. Install the Visual Studio Remote Debugger:
administrative_image_directory\VSRemoteDebugger\install.exe /Q

7. Install Visual Basic 7.1:
administrative_image_directory\Microsoft_VBA\vba71.msi and
administrative_image_directory\Microsoft_VBA\vba71_1033.msi are required for
all languages.

Only the 64-bit version of this package must be installed.

In addition, install the following package for the desired language:
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Chinesevba71_1028.msi

Germanvba71_1031.msi

Frenchvba71_1036.msi

Italianvba71_1040.msi

Japanesevba71_1041.msi

Koreanvba71_1042.msi

Portuguese-Brazilianvba71_1046.msi

Chinese-Simplifiedvba71_2052.msi

Spanishvba71_3082.msi

English, Czech, Polish, Russian, and Turkish do not require additional language
packages.

As of SOLIDWORKS 2013 Service Pack 2.0, you must install an additional
prerequisite: Msiexec.exe /p vba71-kb27832-x64.msp

8. Install the Bonjour service for Windows:
administrative_image_directory\Bonjour\Bonjour64.msi

Installing from the Administrative Image Using the
Command Line
You can deploy installations from an administrative image using the command line.

To install silently:

1. Open a Command Prompt window (in Windows, click Start > Run.
2. Type the msiexec.exe command with the /i and /qb switches and set the properties
for any options that are not the default values as shown below.

Individual installation component command-line properties include:

• Command-Line Feature Properties on page 44
• Command-Line Global Properties on page 45
• eDrawings Command Line Properties on page 48
• SOLIDWORKS Explorer/Workgroup PDM Command-Line Properties on page 50
• SOLIDWORKS Flow Simulation Command Line Properties on page 52

Use the following examples as templates for silent installation.
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SOLIDWORKS Client

• SOLIDWORKS core (English)
• Toolbox add-in
• Participation in the feedback program
• French language

SOLIDWORKS:

msiexec /i "64-bit_admin_image_path\SOLIDWORKS\SOLIDWORKS.Msi"
INSTALLDIR="C:\Program Files\your_folder" SOLIDWORKSSERIALNUMBER="xxxx xxxx
xxxx xxxx xxxx xxxx" ENABLEPERFORMANCE=1 OFFICEOPTION=3 ADDLOCAL=SolidWorks,
SolidWorksToolbox /qb

The SOLIDWORKS French language installation component must be installed separately:

msiexec /i "64-bit_admin_image_path\SOLIDWORKS French\french.msi" /qb

When specifying SOLIDWORKS language component installation commands, do not
specify command-line arguments.

eDrawings Client

• Log performance
• All features

msiexec /i "admin_image_path\eDrawings\eDrawings.msi" INSTALLDIR="C:\Program
Files\your_folder" LOGPERFORMANCE=1 SNLSERVER=eDrawings_SNL_server
TRANSFORMS=1040.mst ADDLOCAL=All /qb

SOLIDWORKS Explorer and Workgroup PDM add-in

• SOLIDWORKS Explorer with Workgroup PDM add-in

msiexec /i "admin_image_path\SOLIDWORKS Explorer\SOLIDWORKS Explorer.msi"
INSTALLDIR="C:\Program Files\your_folder" EXPLORERORPDM=1
ADDLOCAL=VaultAdmin,Client,Standalone,DocMgr,LicenseEXE
ACTIVSERIALNUMBER="xxxx xxxx xxxx xxxx xxxx xxxx" /qb

SOLIDWORKS Electrical

Due to the technical complexity of installing SOLIDWORKS Electrical with Microsoft SQL
Server, command line examples for SOLIDWORKS Electrical are excluded from the
documentation.
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Command-Line Properties
Command-line properties describe here include feature properties, global properties,
product-specific properties and Windows location conventions.

Command-Line Feature Properties
SOLIDWORKS installation supports these ADDLOCAL properties for command-line
deployment.

• CircuitWorks
• CoreSOLIDWORKSTaskScheduler
• ExampleFiles
• FeatureWorks
• HelpFiles
• Manuals
• Motion
• PhotoView
• RealViewGraphicsdisplay
• ScanTo3D
• Simulation
• SolidWorks
• SolidWorksAnimator
• SolidWorksCosting
• SolidWorksDesignChecker
• SolidWorksRoutedsystems
• SolidWorksToolbox
• SolidWorksUtilities
• TolAnalyst

When specifying properties for command-line installation:

• SOLIDWORKS does not support product installation using the ADDSOURCE option.
• Properties are case sensitive, cannot contain spaces or dashes, and must be separated
by commas.

Mixed case SolidWorksmust be specified in ADDLOCAL properties for the application
to install correctly.
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Command-Line Global Properties
Each property is defined for administrative or individual installations, unless otherwise
noted. Serial numbers can be passed to both an administrative installation and an individual
installation using global properties.

DescriptionProperty

Whether the application should automatically
send performance data to SOLIDWORKS
Corporation.

To send performance data.1

Do not send performance data.0

ENABLEPERFORMANCE

Installation folder for SOLIDWORKS.

Individual installations only.

INSTALLDIR

Serial number for the SOLIDWORKS Model Based
Definition product.

MBDSERIALNUMBER

Serial number for the SOLIDWORKS Motion
product.

MOTIONSERIALNUMBER

Specify product package to install:

SOLIDWORKS Client0

SOLIDWORKS Office1

SOLIDWORKS Professional2

SOLIDWORKS Premium3

OFFICEOPTION

Specify ALL to update all features currently
installed.

Specify this property only when updating to a
Service Pack release within an existing major
release (for example, updating an existing
SOLIDWORKS 2015 SP01 installation to
SOLIDWORKS 2015 SP02).

REINSTALL
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DescriptionProperty

Microsoft Installer re-installation options.

For example, when upgrading an installation from
one Service Pack release to another within the
same major release, you should specify
REINSTALLMODE=vomus.

For details about REINSTALLMODE settings, see
the Windows Installer documentation at
www.microsoft.com.

Specify this property only when updating to a
Service Pack release within an existing major
release (for example, updating an existing
SOLIDWORKS 2015 SP01 installation to
SOLIDWORKS 2015 SP02). Do not specify this
property the first time you are installing a new
major release of SOLIDWORKS.

REINSTALLMODE

SolidNetWork server list.

The SolidNetWork server list is a list of strings
delimited by semi-colons, each of which refers
to a port number on a server with the format:

xxxxx@server_name1;yyyyy@server_name2;&

where x and y are single digits. After the last
server in the list, do not put a semi-colon.

Individual installations only.

SERVERLIST

Serial number for the SOLIDWORKS Simulation
product.

SIMULATIONSERIALNUMBER

Serial number for the SOLIDWORKS product,
which includes all add-ins.

SOLIDWORKSSERIALNUMBER

SOLIDWORKS version to upgrade as it would be
shown in the list in the SOLIDWORKS Install
Choice dialog box. For example:

SWMIGRATE="SOLIDWORKS 2015 x64 Edition
SP01"

Specify this property only when installing a
new major release while there is a prior major
release currently installed. Do not specify this
property when upgrading from one Service
Pack release to another within the same major
release.

SWMIGRATE
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DescriptionProperty

Installation folder for SOLIDWORKS Toolbox files.

Individual installations only.

For example: TOOLBOXFOLDER = "c:\SOLIDWORKS
Data"

TOOLBOXFOLDER

Contains language-specific items of the form:

TRANSFORMS number.mst

• Chinese (1028)
• Chinese-Simplified (2052)
• Czech (1029)
• English (1033)
• French (1036)
• German (1031)
• Italian (1040)
• Japanese (1041)
• Korean (1042)
• Polish (1045)
• Portuguese-Brazilian (1046)
• Russian (1049)
• Spanish (1034)
• Turkish (1055)

TRANSFORMS

Specify whether to upgrade an existing version
of SOLIDWORKS to the current version.

New installation, do not update.0

Update1

Individual installations only.

Specify this property only when installing a
new major release while there is a prior major
release currently installed. Do not specify this
property when upgrading from one service
pack release to another within the same major
release.

UPGRADESWINSTALL
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eDrawings Command Line Properties
These command-line properties are specific to eDrawings®.

DescriptionProperty

Specifies which portion of the eDrawings application to install.

All is the recommended option.

FeatureCommand Line Syntax

Installs all the features. The
eDrawings application searches
for installed SOLIDWORKS and
AutoCAD publisher applications
to validate the install.

All

View CAL files in the eDrawings
Viewer

CALS

Create eDrawings files from the
Autodesk Inventor application.

Inventor

View eDrawings and other files.eDrawingsViewer

View ProE files using the
eDrawings Viewer

ProE

View DXF/DWG files in the
eDrawings Viewer.

DXFDWGTranslator

Install desktop shortcut.Shortcuts

View 3DXML files in the
eDrawings Viewer.

XML3D

ADDLOCAL

Specifies the installation folder for eDrawingsINSTALLDIR

Specifies whether the application should automatically email
performance data to SOLIDWORKS Corporation.

Send performance data1

Otherwise0

LOGPERFORMANCE
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DescriptionProperty

Enter the port@servername for your SolidNetWork License server.
Use semi-colons to separate multiple port@servername
combinations.

A port server name for SNLSERVER is only required for the
SOLIDWORKS SNL server configuration.
list_of_port@server_strings is a list of strings delimited by
semi-colons, each of which refers to a port number on a server
with the format:

xxxxx@server_name1; yyyyy@server_name2;

where x and y are single digits. After the last server in the list, do
not put a semi-colon.

SNLSERVER

SOLIDWORKS Composer/Composer Player Command-Line
Properties
These command-line properties are specific to SOLIDWORKS Composer and SOLIDWORKS
Composer Player.

For SOLIDWORKS Composer:

DescriptionProperty

SOLIDWORKS Composer serial number.ACTIVSERIALNUMBER

Optional. SOLIDWORKS Composer Player
Pro serial number.

ACTIVSERIALNUMBERPLAYERPRO

If you install the complete application, you
do not need to specify the following items.

Required:

• Licensing
• Documents_2D
• Eula
• InterOps
• LicenseSupportFiles
• PlugIns
• SWComposerCommon
• SWPlayer

Optional:

• Sync3Dvia

ADDLOCAL

Specifies the installation folder for the
SOLIDWORKS Composer software.

INSTALLDIR
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For SOLIDWORKS Composer Player:

DescriptionProperty

Optional. SOLIDWORKS Composer Player
Pro serial number.

ACTIVSERIALNUMBERPLAYERPRO

Specifies the installation folder for the
SOLIDWORKS Composer Player software.

INSTALLDIR

SOLIDWORKS Explorer/Workgroup PDM Command-Line Properties
These command-line properties are specific to SOLIDWORKS Explorer and SOLIDWORKS
Workgroup PDM.

For SOLIDWORKS Explorer/Workgroup PDM client:

DescriptionClient Property

SOLIDWORKS Explorer only0

Workgroup PDM features can be
installed

1

EXPLORERORPDM

50

Multiple Installations



DescriptionClient Property

• Standalone
• Client
• Client64
• VaultAdmin
• AutoCADRxxxx
• DocMgr
• DocMgr64
• LicenseEXE

Standalone is the Contributor and Client
is the SOLIDWORKS Add-in for
SOLIDWORKS Explorer silent installations.

If you specify AutoCAD, AutoCAD must be
installed on your system. Workgroup PDM
locates the appropriate version of AutoCAD.
You can specify more than one version of
AutoCAD:

• AutoCADR14Addin
• AutoCADR2000Addin
• AutoCADR2004Addin
• AutoCADR2005Addin
• AutoCADR2006Addin

Client64 and DocMgr64 work with only
64-bit SOLIDWORKS Explorer installations.

ADDLOCAL

Specifies the installation folder for
Workgroup PDM.

INSTALLDIR

Specifies the SOLIDWORKS serial number.ACTIVSERIALNUMBER

For Workgroup PDM Server:

DescriptionServer Property

• Vault
• WebPortal
• API

If you specify WebPortal (the Viewer), you
must also specify VAULTNAME.

ADDLOCAL

Specifies the installation folder for
Workgroup PDM.

INSTALLDIR
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DescriptionServer Property

Specifies the name of the computer where
the license server resides.

LICENSE_SERVER

Specifies the path and folder of the vault.VAULTDATA

Specifies the name of the computer where
the vault resides.

VAULTNAME

SOLIDWORKS Flow Simulation Command Line Properties
These command-line properties are specific to SOLIDWORKS Flow Simulation.

DescriptionProperty

SOLIDWORKS Flow Simulation standalone
serial number.

(Individual installations and client
installations from an administrative image)

ACTIVSERIALNUMBER

Upgrades an existing version of a particular
SOLIDWORKS Flow Simulation application
software.

Update1

New installation; install in a new
directory

2

(Individual installations and client
installations from an administrative image)

CWUPGRADEINSTALL

Specifies the installation for a particular
SOLIDWORKS Flow Simulation application
software.

(Individual installations only)

INSTALLDIR

List of strings delimited by semi-colons,
each of which refers to a port number on a
server with the format:
xxxxx@server_name1;
yyyyy@server_name2;& where x and y are
single digits. After the last server in the list,
do not put a semi-colon.

SERVERLIST
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DescriptionProperty

Specifies the folder where the SOLIDWORKS
software is installed.

(Individual installations and client
installations from an administrative image)

SOLIDWORKSPATH

SOLIDWORKS Inspection Command Line Properties
These command-line properties are specific to SOLIDWORKS Inspection.

DescriptionProperty

SOLIDWORKS Inspection serial number.

(Individual installations and client
installations from an administrative image)

ACTIVSERIALNUMBER

Specifies the installation for the
SOLIDWORKS Inspection application
software.

(Individual installations only)

INSTALLDIR

List of strings delimited by semi-colons,
each of which refers to a port number on a
server with the format:
xxxxx@server_name1;
yyyyy@server_name2;& where x and y are
single digits. After the last server in the list,
do not put a semi-colon.

SERVERLIST

MSI File Locations for Administrative Images
To create administrative images from the command line, the product component .msi
files are stored in these locations on the SOLIDWORKS media.

SOLIDWORKS (core product, English)

swwi\data\SOLIDWORKS.msi

SOLIDWORKS (non-English language components)

swwi\lang\chinese\chinese.msiTraditional
Chinese

swwi\lang\chinese-simplified\chinese-simplified.msiSimplified
Chinese
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swwi\lang\czech\czech.msiCzech

swwi\lang\french\french.msiFrench

swwi\lang\german\german.msiGerman

swwi\lang\italian\italian.msiItalian

swwi\lang\japanese\japanese.msiJapanese

swwi\lang\korean\korean.msiKorean

swwi\lang\polish\polish.msiPolish

swwi\lang\portuguese-brazilian\portuguese-brazilian.msiPortuguese
(Brazilian)

swwi\lang\russian\russian.msiRussian

swwi\lang\spanish\spanish.msiSpanish

swwi\lang\turkish\turkish.msiTurkish

DocManager APIs

swdocmgr\SOLIDWORKS Document Manager API.msi

eDrawings

eDrawings\eDrawings.msi

eDrawingsAPI SDK

eDrwAPISDK\eDrawings API SDK.msi

eDrawings Shaders

eDrawingsShaders\eDrawings.msi

Flow Simulation

Flow Simulation\SOLIDWORKS Flow Simulation.msi

PhotoView 360 Network Render

pvnetworkrender\pvnetrender.msi

SolidNetWork License Manager

swlicmgr\SOLIDWORKS SolidNetWork License Manager.msi
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SOLIDWORKS Activation Wizard

swactwizard\Activation Wizard.msi

SOLIDWORKS API SDK

apisdk\SOLIDWORKS API SDK.msi

SOLIDWORKS Composer

composer\SOLIDWORKS Composer.msi

SOLIDWORKS Explorer

swexplorer\SOLIDWORKS Explorer.msi

SOLIDWORKS Inspection

Inspection\SOLIDWORKS Inspection.msi

SOLIDWORKS PDM

SOLIDWORKS PDM Professional provides an API, but it is available only for the Client and
is not available in an .msi file. For information, see the API guide in the SOLIDWORKS
PDM Client install\API directory.

SOLIDWORKS Plastics

plastics\SOLIDWORKS Plastics.msi

SOLIDWORKS Viewer

swviewer\SOLIDWORKS Viewer.msi

Workgroup PDM Server

pdmwserver\SOLIDWORKS Workgroup PDM Server.msi

Deploying an Administrative Image Using Microsoft Active
Directory
Microsoft Active Directory Deployment is supported for deployment of the core
SOLIDWORKS product to clients.

Microsoft Active Directory is a directory service for managing clients and servers in network
environments. It simplifies management, migration, and deployment.

1. Create an administrative image using SOLIDWORKS Installation Manager.
2. If you have created the administrative image using the command line, install the

Windows prerequisites for installation from an administrative image using Microsoft
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Active Directory. For details, see Installing Windows Prerequisites Using
Microsoft Active Directory on page 57.

Perform this step only if you created the image manually using the command line.
If you created and installed the image using SOLIDWORKS Installation Manager,
all Windows prerequisites were installed automatically.

3. Create a transform file to customize the SOLIDWORKS software:
a) Open the Command Prompt window.
b) In the folder that contains the administrative image, drag SWCreateMST.exe into
the Command Prompt window.
The command should be in the format:

administrative_image_directory\SWCreateMST.exe
path_to_MSI_file_of_an_administrative_image list_of_properties

Properties can be feature properties or global properties. For details, see
Command-Line Feature Properties on page 44 and Command-Line Global
Properties on page 45.

Use the following example as a template:

C:\admin\SWCreateMST.exe "c:\admin\SOLIDWORKS.msi"
INSTALLDIR="C:\Program Files\your_folder" SOLIDWORKSSERIALNUMBER="xxxx
xxxx xxxx xxxx" ADDLOCAL=SOLIDWORKS,Manuals OFFICEOPTION=0
SERVERLIST="25734@your_server"

The transform file, SOLIDWORKS.mst, is created in the folder that contains the
administrative image.

4. In the Active Directory, edit the Published Apps policy for the group or groups to
deploy the SOLIDWORKS software.

5. In the Group Policy dialog box, expand Computer Configuration and Software Settings.
6. Right-click Software installation and select New > Package.
7. Browse to the administrative image and click Open.
8. In the Deploy Software dialog box, select Advanced published or assigned, then

click OK.
9. In the SOLIDWORKS Properties dialog box, on the Modifications tab:

a) Click Add.
b) Browse to the .mst file.
c) Click Open.

10. Click OK.
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Installing Windows Prerequisites Using Microsoft Active
Directory
Follow this process to prepare an existing administrative image that will install
SOLIDWORKS onto client computers using Microsoft Windows Active Directory.

1. Extract all the Visual C++ Redistributable Package installer files and install them.
a) Visual C++ 2005

1. administrative_image_directory\Microsoft_C++_2005_Redistributable\vcredist_x86.exe
/C /T: {Target Directory}

2. administrative_image_directory\Microsoft_C++_2005_Redistributable_(64)\vcredist_x64.exe
/C /T: {Target Directory}

3. Create a policy to install Microsoft C++ 2005 redistributable modules.

b) Visual C++ 2008

1. administrative_image_directory\Microsoft_C++_2008_Redistributable\vcredist_x86.exe
/x: {Target Directory}

2. administrative_image_directory\Microsoft_C++_2008_Redistributable_(64)\vcredist_x64.exe
/x: {Target Directory}

3. Create a policy to install Microsoft C++ 2008 redistributable modules.

c) Visual C++ 2010

1. administrative_image_directory\Microsoft_C++_2010_Redistributable\vcredist_x86.exe
/x:{Target Directory}

2. administrative_image_directory\Microsoft_C++_2010_Redistributable\vcredist_x64.exe
/x:{Target Directory}

3. Create a policy to install Microsoft C++ 2010 redistributable modules.

d) Visual C++ 2012

1. Install
admistrative_image_directory\Microsoft_C++_2012_Redistributable\vcredist_x86.exe
on a test machine.

2. Copy these folders to a network location (Target Directory):

a. C:\ProgramData\PackageCache\{BD95A8CD-1D9F-35AD-981A-3E7925026EBB}v11.0.61030
b. C:\ProgramData\PackageCache\{B175520C-86A2-35A7-8619-86DC379688B9}v11.0.61030

3. Create a policy to install the following files:

File path cannot contain spaces.

Target Directory\
{BD95A8CD-1D9F-35AD-981A-3E7925026EBB}v11.0.61030\packages\

vcRuntimeMinimum_x86\vc_runtimeMinimum_x86.msi

Target Directory\
{B175520C-86A2-35A7-8619-86DC379688B9}v11.0.61030\packages\

vcRuntimeAdditional_x86\vc_runtimeAdditional_x86.msi
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4. Install administrative_image_directory\Microsoft_
C++_2012_Redistributable_(64)\vcredist_x64.exe on a test machine.

5. Copy these folders to a network location (Target Directory):

a. C:\ProgramData\PackageCache\{CF2BEA3C-26EA-32F8-AA9B-331F7E34BA97}v11.0.61030
b. C:\ProgramData\PackageCache\{37B8F9C7-03FB-3253-8781-2517C99D7C00}v11.0.61030

6. Create a policy to install the following files:

File path cannot contain spaces.

Target Directory\
{CF2BEA3C-26EA-32F8-AA9B-331F7E34BA97}v11.0.61030\packages\

vcRuntimeMinimum_amd64\vc_runtimeMinimum_x64.msi

Target Directory\
{CF2BEA3C-26EA-32F8-AA9B-331F7E34BA97}v11.0.61030\packages\

vcRuntimeMinimum_amd64\vc_runtimeMinimum_x64.msi

Target Directory\
{37B8F9C7-03FB-3253-8781-2517C99D7C00}v11.0.61030\packages\

vcRuntimeAdditionalamd64\vc_runtimeAdditionalx64.msi

2. Install Microsoft .NET Framework 4.5.

SOLIDWORKS recommends that you install .NET Framework 4.5 using Windows
Updates Services (WSUS) or a similar service.

3. Extract the Office Web Components files and install them.
a) Run this command:

administrative_image_directory\OfficeWeb_11\owc11.exe
/extract:{Office_Web_components_directory}

b) Create a policy to install the Office Web Components:
{Office_Web_components_directory}\owc11.MSI

No transform file is needed for this installation.

4. Install the Visual Studio Remote Debugger (64-bit versions only when .Net Framework
3.5 is installed on the computer), by creating this policy:
{Microsoft_remote_debugger_directory}\rdbgexp.MSI

No transform file is needed for this installation.
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5. Do the following tasks:
a) Update Visual Basic 7.1 for applications with vba71-kb2783832-x64 service pack.
b) After creating the administrative image, run this command:

Msiexec /a {SOLIDWORKS Administrative image}/Microsoft_vba/vba71.msi
/p {SOLIDWORKS Administrative image}/Microsoft_vba_
kb2783832/vba71-kb2783832-x64.msp

c) Install Visual Basic 7.1, by creating this policy:
{VBA directory}\vba71.MSI

No transform file is needed for this installation.

6. Install the Visual basic 7.1 language pack by creating this policy:
{VBA directory}\vba71_nnnn.MSI

Where nnnn defines the required language:

• 1028 = Chinese
• 1031 = German
• 1033 = English
• 1036 = French
• 1040 = Italian
• 1041 = Japanese
• 1042 = Korean
• 1046 = Portuguese
• 2052 = Chinese - China
• 3082 = Spanish

7. Install the Bonjour Service by creating this policy:
{Bonjour directory}\Bonjour.MSI

No transform file is needed for this installation.

Administration of Multiple Installations
For multiple installations, administrative tasks include upgrading administrative images
to new releases, applying service pack updates, and removing installations.

Upgrading Administrative Images to a New Release
To update clients who installed from an administrative image, first update the
administrative image and then configure the clients to reference the new copy of the
image.

Run SOLIDWORKS Installation Manager from the Internet so that the correct files are
referenced. SOLIDWORKS Installation Manager will redirect itself to do this, or you can
run the update directly from the SOLIDWORKS Downloads Web site
(http://www.solidworks.com/sw/support/downloads.htm).

Once you have updated the administrative image (which creates a new copy of the image),
you can update clients by having them reference the new copy of the administrative
image.
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If clients referenced the previous version of the administrative image using a mapped
drive or a shared directory, you could redefine that mapped drive or shared directory
using the location of the updated copy of the administrative image.

Downloading Updated Installation Files for Administrative Images
SOLIDWORKS Installation Manager can detect when you need updated installation files
when upgrading an administrative image.

1. Start SOLIDWORKS Installation Manager by inserting the DVD.
2. On the Welcome screen, select Administrative image.
3. On the Serial Number screen, enter the SOLIDWORKS serial number.

SOLIDWORKS Installation Manager checks the SOLIDWORKSWeb site for your licensed
products and available service packs.

4. If the Newer Version Available screen appears, select Yes, download and install a
newer version: version.
SOLIDWORKS Installation Manager starts a new session to install the newer version.

5. If there is a problem with the download folder, Download Options might appear, in
which case, accept the default directory for the new installation files or enter a new
directory name.

If you see a message that the directory does not exist, click Yes to create it.

6. On the Download Complete screen, click Close to close the current installer and start
the installer for the new version.

Upgrading an Administrative Image
To upgrade an administrative image, SOLIDWORKS Installation Manager creates a new
image directory. You then direct clients to use the new administrative image directory to
upgrade to that product version.

This process assumes you have downloaded any updated installation files for the
administrative image. For details, see Downloading Updated Installation Files for
Administrative Images.

1. Start SOLIDWORKS Installation Manager. For details, see Initiating SOLIDWORKS
Installation.

2. On the Welcome screen, select Administrative image.
Administrative image creation options appear.

DescriptionOption

Create the image using the default configuration
settings (that is, not based on the settings currently
established for an existing administrative image at
your site).

Create a new image using
default settings.
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DescriptionOption

Create the image using configuration settings
specified for an existing administrative image at your
site. Click Browse to specify the installation directory
for the existing administrative image.

Create a new image using
settings and files from an
existing image.

3. On the Serial Number screen, check the serial number.
4. On the Summary (Ready to Create Image) screen, check that the administrative

image options are correct.
For details about individual administrative image and installation options, click
CHANGE to go to the option page and then click Help.

5. To create the new version of the administrative image, click Create Now.

You can now upgrade clients to this new version of the administrative image. For details,
see Upgrading Clients from Administrative Images.

Upgrading Clients from Administrative Images
SOLIDWORKS Installation Manager can automatically update client computers installed
from an administrative image.

Typically, administrative images are organized in folders on a server. To support the
automatic upgrade of clients, the administrative image must be located in a shared folder.

After upgrading the administrative image, the original installation will be in one folder
and the upgraded installation will be in another folder. To use the upgraded installation,
remove the sharing option from the original administrative image folder and then add
the sharing option to the upgraded administrative image folder.

When SOLIDWORKS starts on a client machine that installed from the original
administrative image, it sees the new version and upgrades the client.

Removing the Sharing Option from the Original Administrative Image
Folder
When upgrading an administrative image that is accessed from a shared folder, you must
remove the sharing option from the original folder.

1. Browse to the folder where the original administrative image files are located.
2. Right-click the folder and select Properties.
3. On the Sharing tab, select Do not share this folder, and then click OK.

Now add the sharing option to the upgraded administrative image folder as described in
Adding the Sharing Option to an Upgraded Administrative Image Folder.
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Adding the Sharing Option to an Upgraded Administrative Image Folder
Once you have created an updated administrative image folder and disabled the sharing
for the original administrative image folder, you must add the sharing option to the new
folder to re-enable the administrative image.

1. Browse to the folder where the upgraded administrative image files are located.
2. Right-click the folder and select Properties.
3. On the Sharing tab, specify the sharing properties appropriate for your organization

or group and change the share name to the name used for the original administrative
image folder.

Computers that installed from the original administrative image share location will upgrade
to the new version automatically when starting SOLIDWORKS.

Service Pack Product Update Administration
Service Pack product updates can contain updates for system reliability, program
compatibility, security, and so on.

You can acquire product updates in two ways:

• By using SOLIDWORKS Installation Manager to check for, download, and install updates.

You can initiate SOLIDWORKS Installation Manager manually, or schedule it to check
periodically for updates.

• By downloading service packs manually from the SOLIDWORKS support Web site.

Service packs are applied as patches to an existing software version. For example,
SOLIDWORKS 2015 SP1.0 is a service pack for SOLIDWORKS 2015 SP0.0. You can
install these service packs using SOLIDWORKS 2015 Installation Manager; you cannot
install them using SOLIDWORKS Installation Manager in SOLIDWORKS 2016.

For instructions on downloading and installing service packs, see the installation
documentation for the SOLIDWORKS version you are updating.

Rolling Back Service Packs in an Administrative Image
You can roll back an administrative image to an earlier installed service pack. If you
installed the SOLIDWORKS software with disks, you need the original disks to restore a
service pack. You must have saved a copy of the earlier administrative image.

Administrative images that have been upgraded cannot be rolled back to a previous
service pack. Administrative images created with any method other than SOLIDWORKS
Installation Manager cannot be rolled back to a previous version. Clients installed from
these administrative images must be uninstalled and then reinstalled using an
administrative image created from the previous version.
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1. Delete the folder that contains the current administrative image. To do this, open the
Command Prompt window and enter:
rmdir /s/q path_to_current_administrative_image

2. Move the backup copy of the administrative image to the location where you deleted
the current administrative image. To do this, open the Command Prompt window and
enter:
move path_to_backup_administrative_image
path_to_current_administrative_image

After you roll back an administrative image, client computers roll back automatically
the next time they run the SOLIDWORKS software.

Applying Service Packs to Clients Deployed with Microsoft Active
Directory
If you have installed the SOLIDWORKS software using the Microsoft Active Directory, you
can apply service packs to clients with it.

1. Copy the administrative image to a new folder using the following command line:
xcopy path_to_current_administrative_image
path_to_backup_administrative_image /s/i/v

2. Upgrade the administrative image using the SOLIDWORKS Installation Manager.
3. Create a new transform file to specify an upgrade installation for the SOLIDWORKS

software:
a) Open the Command Prompt window.
b) In the folder that contains the administrative image, drag SWCreateMST.exe into
the Command Prompt window.
The command format is:

path_to_administrative_image\SWCreateMST.exe
path_to_MSI_file_of_an_administrative_image list_of_properties

The command line must include all of the parameters used to create the original
transform file, plus the global properties UPGRADESWINSTALL and SWMIGRATE.

For example, if the original command was:

C:\admin\SWCreateMST.exe "c:\admin\SOLIDWORKS.msi"
INSTALLDIR="C:\Program Files\your_folder" SOLIDWORKSSERIALNUMBER="xxxx
xxxx xxxx xxxx" ADDLOCAL=SOLIDWORKS,Manuals OFFICEOPTION=0
SERVERLIST=25734@your_server

the update command must be:

C:\admin\SWCreateMST.exe "c:\admin\SOLIDWORKS.msi"
INSTALLDIR="C:\Program Files\your_folder" SOLIDWORKSSERIALNUMBER="xxxx
xxxx xxxx xxxx" ADDLOCAL=SOLIDWORKS,Manuals OFFICEOPTION=0
SERVERLIST=25734@your_server UPGRADESWINSTALL=1 SWMIGRATE="SOLIDWORKS
version service_pack"

The transform file, SOLIDWORKS.mst, is created in the folder that contains the
administrative image.
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4. In the Active Directory, edit the Published Apps policy for the group or groups to
deploy the SOLIDWORKS software.

5. In the Group Policy dialog box, expand Computer Configuration and Software
Settings.

6. Right-click Software installation and select New > Package.
7. Browse to the administrative image and click Open.
8. In the Deploy Software dialog box, select Advanced published or assigned, then

click OK.
9. In the SOLIDWORKS Properties dialog box, on the Modifications tab:

a) Click Add.
b) Browse to the .mst file.
c) Click Open.

10. Click OK.

Removing an Installation
You can remove an installation on an individual computer or in a client/server environment.

1. Make sure no SOLIDWORKS sessions are active.
2. If you wish to move the SOLIDWORKS license to another computer, deactivate the

license to that computer before removing the SOLIDWORKS installation on this
computer.

For more information, see Moving a License.

3. In Windows 7 or later, launch the Control Panel > Programs and Features.
4. Select the product component to remove.

In some cases, you might find multiple SOLIDWORKS Service Pack components
for a given major release version. To remove a SOLIDWORKS major release, remove
all Service Pack elements for that major release.

5. On the Uninstall screen:
a) Select the products to remove. By default, all product components are selected.
b) Clear the products that you do not want to remove.
c) Choose whether to perform a custom or complete uninstall. By default, the
SOLIDWORKS Installation Manager performs a standard uninstall and removes the
Program Files and Folders.

1. Click Change in Advanced Options.

The Advanced Options screen appears and the Program Files and Folders option
is selected

2. Select one or more options to perform a custom uninstall, or select all options
to perform a complete uninstall.

3. Click Back to Summary.
4. On the Summary screen, expand Advanced Options to display the uninstall
method and entries.

d) Click Remove Items.
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4
SOLIDWORKS Workgroup PDM
A Workgroup PDM system is illustrated as follows:

• A computer can contain only one Vault.
• The Vault directory cannot be a hidden or read-only directory.
• As a client/server application, Workgroup PDM performance depends on a robust network.
• If your users maintain a large number of documents, performance is improved if you
create more projects or subprojects with fewer documents per project instead of keeping
the documents in a smaller number of projects with more documents per project.

End-of-Life Announcement

SOLIDWORKS Workgroup PDM support will end after SOLIDWORKS 2017. Customers already
using SOLIDWORKS Workgroup PDM can continue to install it, but should begin planning to
migrate file vaults to SOLIDWORKS PDM Server.

Installation

• Clients and the VaultAdmin, API, and Viewer can be installed on the same computer as the
Vault, or on different computers.

• It is not necessary to install the Workgroup PDM Server to install the client API. The client
API is installed during the Workgroup PDM Client installation.

• To configure the vault folder on a remote location, type the full Universal Naming Convention
(UNC) path when prompted for the server destination. (For details, see UNC Format on
page 140.)

• Installing or updating the vault requires a computer reboot.
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• If the Workgroup PDM Server Service does not start automatically after rebooting, you must
start it manually. In Windows Explorer, run pdmwvault.exe in the drive letter:\
SOLIDWORKS Workgroup PDM\Vault folder.

• When you install a Workgroup PDM client, you must install solidworksexplorer.exe on
each computer. This executable can be on a shared drive. The Workgroup PDM Vault, Viewer,
API Client, and VaultAdmin are not installed on each client computer.

If you are running Windows 8, refer to Tips for Using SOLIDWORKS with Microsoft Windows
for tasks such as accessing Start or the Control Panel. These steps may vary depending
on how Windows 8 is configured on your system. Consult Microsoft Windows documentation
for additional instructions and options.

Licenses

• A license for Workgroup PDM API is included with the licenses of SOLIDWORKS clients and
Explorer clients. Check-in APIs require client licenses.

• A Workgroup PDM Viewer license must be installed with the vault to enable the Viewer.

Permissions

• The vault administrator should have write permission for installation and for the vault folder.
• The vault administrator should manage the vault folder from the VaultAdmin, not with
Windows Explorer.

• Users should never have write permission in Windows Explorer for the vault folder.

Security, Ports, and Duplex Settings

• Workgroup PDM must be able to install as a Windows service, so other applications cannot
be allowed to block or filter the service. For example, if anti-spyware tools such as Microsoft
AntiSpyware display an alert requiring approval during the installation process, click Allow
so the Workgroup PDM Server is installed as a Windows Service.

• If you install Workgroup PDM on a computer with an active firewall, you must enable
Workgroup PDM ports as exceptions in the firewall setup.

Typically, the ports are:

• 20000 (VaultAdmin)
• 30000 (Data)
• 40000 (Request)
• 80 (Viewer)

For information on changing the port settings, see Troubleshooting for Vault Administrators
in the Workgroup PDM and SOLIDWORKS Explorer help and the Microsoft Windows help for
Security Center. To install the Workgroup PDM Vault and the Viewer concurrently, use the
Custom option in the Setup Type dialog box.

• The duplex setting for servers and their corresponding ports should be the same; for example,
both could be 100MB Full or both could be Auto.

SOLIDWORKS Toolbox Documents

SOLIDWORKS Toolbox documents are common hardware components that usually do not
require revision control and are not checked in to the Workgroup PDM Vault. See theWorkgroup
PDM online help for details about configuring SOLIDWORKS Toolbox and other standard libraries.
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This chapter includes the following topics:

• Workgroup PDM Viewer
• Installing a Workgroup PDM Server
• Configuring Workgroup PDM for Clients
• Installing Workgroup PDM Server and Viewer in a Perimeter Network
• Workgroup PDM Client Access
• Workgroup PDM VaultAdmin Administration

Workgroup PDM Viewer
The Workgroup PDM software automatically sets up a virtual directory during installation
using Microsoft Internet Information Services (IIS).

You must install Microsoft Internet Information Services (IIS) before installing the
Viewer.

Required components include:

• Web Management Tools

• IIS Management Console

• World Wide Web Services: Application Development Features

• .NET Extensibility
• ASP.NET
• CGI
• ISAPI Extensions
• ISAPI Filters

See Microsoft documentation for IIS installation instructions.

The Workgroup PDM Viewer installation is subject to these restrictions:

• The Web Site Content Directory is the Viewer installation folder.
• You cannot use underscore characters in the name of the machine that hosts the Viewer.
• The Viewer can point to only a single vault at any time.

Users access the Workgroup PDM Viewer by typing this URL into the address field of
Internet Explorer:

http://ViewerComputerName/pdmweb/

Installing a Workgroup PDM Server
Installing the Workgroup PDM Server creates a Workgroup PDM vault, which is the
database that stores the managed SOLIDWORKS projects.

1. Start SOLIDWORKS Installation Manager. See Initiating SOLIDWORKS Installation.
2. On the Welcome screen, select the following:

• Server products
• Install SOLIDWORKS Workgroup PDM Server (vault) on this computer.
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3. On the Summary screen, click Change to acquire a validation code. You can acquire
the code using one of the following methods:

• Internet connection

1. Enter the SOLIDWORKS serial number and an email address in the fields
provided.

2. Select Validate automatically and click Get Code.

• Email

1. If your computer does not have access to an Internet connection, click Validate
manually by email. The Installation Manager generates a Validation Request
file.

2. Click Save to store the file locally on the system.
3. Follow the instructions on the screen and enter the validation code.

4. Click Back to Summary.
5. On the Summary screen, click Install Now.

Configuring Workgroup PDM for Clients
After you have installed the Workgroup PDM server vault, you can then configure the
vault for clients.

1. Log in to the VaultAdmin (installed with SOLIDWORKS Explorer) with the default user
name and password.

2. In the VaultAdmin, set up user and group accounts, project folders, permissions, and
so on.

For instructions, see Workgroup PDM Help.

3. Email client users with the server computer name and their user names and passwords,
which are usually not the same as their Microsoft Windows user names and passwords.

Configuring the Workgroup PDM Viewer to Connect to a
Different Vault Location
You can configure Workgroup PDM Viewer to connect to a different Vault location using
the Windows Registry.

1. Update the registry path by changing the Vault Computer value:
HKEY_LOCAL_MACHINE\SOFTWARE\SOLIDWORKS\SOLIDWORKS
2015\PDMWorks Workgroup\Vault Computer

2. Reinstall the Workgroup PDM Viewer. In the Vault Computer Name dialog box, type
the new computer name.
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Configuring Mime Types for Document Downloading
You can configure mime types for document downloading using Windows Registry settings.

By default, the Viewer sends Open Document requests with the generic mime type
"application/octet-stream." Microsoft Internet Explorer then opens the requested document
with the supplied file extension. You can map additional mime types or turn off mime
type mappings by modifying the Mime Types registry sub-key in Windows Registry.

To map additional mime types, create additional string values under this registry
sub-key:
HKEY_LOCAL_MACHINE\SOFTWARE\SOLIDWORKS\SOLIDWORKS
2015\PDMWorks Workgroup\WebPortal\Mime Types

in the form:

"ext" = "mime type"

For example:

"dxf" = "image/vnd.dxf"

You must manually create this registry sub-key before you add the values.

To turn off mime type mappings, change the Use Custom MIME Types registry
value to 0 (zero).

HKEY_LOCAL_MACHINE\SOFTWARE\SOLIDWORKS\SOLIDWORKS
2015\PDMWorks Workgroup\WebPortal\Use Custom MIME Types

Restarting the web server is not required to activate this setting.

InstallingWorkgroup PDMServer and Viewer in a Perimeter
Network

Installing a SOLIDWORKS Workgroup PDM Web server and Workgroup PDM Viewer in a
perimeter network (DMZ) has firewall implications.

Because Workgroup PDM Viewer clients communicate with the Web server over the HTTP
or HTTPS ports, these ports must be open on the Internet Information Server (IIS) system
where the Web server is installed.

• For the HTTP protocol, the default port is 80.
• For the HTTPS protocol (SSL), the default port is 443.

The Web Viewer clients themselves do not need firewall exceptions.

You must ensure that the Web server system can reach the Vault server over these default
ports:

• 30000 (Data)
• 40000 (Request)
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Network Configuration for Workgroup PDM Viewer in a
Perimeter Network
The network configuration shows a perimeter network server set up on a perimeter subnet
and its communication to the internal and external networks.

The perimeter network server communicates to the LAN through an internal firewall. It
communicates to the external network through an external firewall, a router, and a cluster
of load balancers.

The Internet Explorer client connects to the Workgroup PDM Viewer/IIS server by way
of port 80 (or 443 if configured to use SSL). The Workgroup PDM Viewer then connects
to the Vault server using ports 30000 or 40000. The Vault server sends the requested
information back to the Workgroup PDM Viewer, which then feeds the information back
to the Internet Explorer client.

The perimeter network Web server has two IP addresses:

• The internal IP address on the LAN
• The public IP address provided by the ISP

The Web server in the perimeter network is located behind a cluster of load balancers.
Although you can get directly to the Web server for administrative tasks, all Web services
traffic to the servers in the perimeter network is processed through the load balancers.
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The load balancers translate the server hardware IP address to a virtual IP (VIP) on the
network leg that is exposed to the public. If you browse to either the VIP or the Web
server URL while attached to the network, you can see the site.

The external firewall translates the load balancer VIP to a public, route-able address.

Installing and Configuring theWorkgroup PDMWeb Server
and Viewer
When you set up a Workgroup PDM Web server in a perimeter network, the installation
location of the components is important.

• Install the IIS-enabled Web server on the perimeter subnet.
• Install the IIS-enabled Workgroup PDM Viewer on the perimeter subnet.
• Install the Workgroup PDM Vault on the primary domain or internal network on the
local intranet.

The prerequisites for installing and configuring Workgroup PDM Viewer in a perimeter
network are:

• Microsoft IIS 6.0 or later
• A public IP address to the Web server on the perimeter subnet, assigned by your ISP
provider

To install and configure the Workgroup PDM components:

1. Install Microsoft IIS on the perimeter subnet server system.
2. Perform two SOLIDWORKS Workgroup PDM Server installations:

a) First, install the Vault component on the Vault server.
b) Run the installer a second time and install the Workgroup PDM Viewer and Viewer
license components on the IIS Web server. Enter the vault server computer name
so that the Web portal knows where to look for the Vault server service.

When you perform the installation, the PDMWeb application is added automatically
to the default IIS Web site.

3. Ensure that the firewall to the internal network has ports 30000 and 40000 open.
4. If the internal server has a fixed IP address, on the perimeter server system, edit the

C:\Windows\system32\drivers\etc\hosts file. Create a system name to IP address
mapping so that the perimeter server can communicate with the internal server:
a) Open the hosts file in a text editor such as Notepad.
b) Add a new line for the Vault server IP address and name.
c) Save the hosts file.
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Workgroup PDM Client Access
Workgroup PDM clients use Microsoft Windows login access control, have Web access
through the Workgroup PDM Viewer, and are updated automatically whenever the
Workgroup PDM Vault has been updated.

Client user names and passwords are not the same in
Workgroup PDM as for Microsoft Windows login. Contact
your system administrator for login information.

To log in as a Workgroup
PDM client:

Contact your system administrator for the URL to connect
to the Viewer.To connect to the

Workgroup PDM Viewer:

The Workgroup PDM clients (SOLIDWORKS add-in and
Contributor) detect when the Vault has been updated. You
do not need to download a service pack to update clients.

To update theWorkgroup
PDM clients:

Workgroup PDM VaultAdmin Administration
After Workgroup PDM is installed, vault administrators should perform these tasks.

• Log in to the VaultAdmin.
• Change the vault administrator password.
• Create user accounts.
• Notify users of their account names and passwords.

For details, see SOLIDWORKS Workgroup PDM in the main SOLIDWORKS help.

Initial Login to Workgroup PDM VaultAdmin
When you first login to Workgroup PDM VaultAdmin, specify the Workgroup PDM
administrator name and password, and the name of the computer hosting the Workgroup
PDM Vault.

1. In Windows, click Start > All Programs > SOLIDWORKS version > Workgroup
PDM VaultAdmin.

2. In the dialog box, enter this information:

pdmwadminName

pdmwadminPassword

The host name of the computer where the vault is installed. If you
run the VaultAdmin on the computer where the vault is installed,
type localhost.

Vault
computer

3. Click Login.
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For security reasons, we recommend that you change the password for the administrator
as soon as possible. Select the Users and Groups tab in the VaultAdmin.

Upgrading the Workgroup PDM Vault Server
You can upgrade the Workgroup PDM Vault Server using SOLIDWORKS Check for Updates,
a SOLIDWORKS installation DVD, or a Workgroup PDM upgrade file manually downloaded
to a local folder.

You can install only one version of Workgroup PDM Vault Server

1. Ask all users to log out of the Workgroup PDM vault and then lock it.
2. Backup the vault data.
3. Use Microsoft Windows Control Panel Add/Remove Programs to remove the current

version of Workgroup PDM Server.
4. Install the new version of Workgroup PDM Server.

• To use SOLIDWORKS Check for Updates:

1. In Windows, click Start > All Programs > SOLIDWORKS Installation
Manager > Check for Updates.

2. In the Newer Versions Available dialog box, select Download and install a
new version, select the version to install, and then click Next.

The new version of SOLIDWORKS Installation Manager downloads and runs.

• To use a SOLIDWORKS installation DVD, insert the DVD into the drive and follow
the SOLIDWORKS Installation Manager instructions.

• To use the manually downloaded Workgroup PDM installation file (pdmwserver.exe),
double-click the file and then follow the instructions to upgrade the Workgroup
PDM Server.

5. Use SOLIDWORKS Task Scheduler to update the Workgroup PDM files in the vault.
6. Unlock the vault and then notify users that they can return to using it.

Upgrading Workgroup PDM Clients
Clients are prompted to update the first time they log in after the vault is updated. No
service pack is required for client updates.

ActionClient Status Relative to Vault

NoneSame version as vault

NoneSame major release, newer than vault

Login is blockedNewer major release, newer than vault

Optional updateSame major release, older than vault

Mandatory updateOlder major release, older than vault
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For details about updating Workgroup PDM clients, see Update Clients in the Workgroup
PDM Help.
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5
SOLIDWORKS PDM
SOLIDWORKS PDM is available in two types:

• SOLIDWORKS PDM Standard
• SOLIDWORKS PDM Professional

SOLIDWORKS PDM uses a Microsoft SQL Server database to manage file vaults.

This table lists the database systems, server components and client options available for each
product type.

PDM ProfessionalPDM Standard

Large office networks, large
numbers of concurrent users

Small to medium office
networks, generally with less
than 20 concurrent users.

Designed for

SQL Standard limits: Lesser of
4 sockets or 16 cores, 128 GB
of RAM, and 524 PB database
size

Lesser of 1 sockets or 4 cores,
1 GB of RAM, and 10 GB
database size

Limits

Microsoft SQL Server 2014
(included separately with
SOLIDWORKS), or previously
installed instances of Microsoft
SQL Server 2014, 2012, or
2008 R2

Microsoft SQL Server Express
2014 (included and installed
with SOLIDWORKS)

Database Management System

YesYesRequires SolidNetWork License
Manager?

YesYesIncludes Archive Server and
Database Server?

YesNoIncludes SOLIDWORKS PDM
Web server and Web2 Server?

Native, browser-basedNativeClient types

SOLIDWORKS, DraftSight,
Microsoft Office Integration,
Autodesk Inventor, AutoCAD

SOLIDWORKS, DraftSightClient add-ins for CAD Editors

DraftSight, Microsoft Office
Integration

DraftSightClient add-ins for Contributors
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PDM ProfessionalPDM Standard

Microsoft Office IntegrationClient add-ins for Viewers

This chapter includes the following topics:

• Listing of PDM Server Components
• Before Installing PDM Server
• Installing a PDM Server with SLDIM
• Understanding Differences between PDM Clients
• Installing a PDM Client with SLDIM

Listing of PDM Server Components
This table summarizes the server components of the SOLIDWORKS PDM Server.

InstallationFunctionServer

Can install with PDM
Standard, or use a version
previously licensed and
installed.

Manages data in
SOLIDWORKS PDM data
vaults.

Microsoft SQL Server Express
for PDM Standard

Ships separately with PDM
Professional. You can also
use a version previously
licensed and installed.

Manages data in
SOLIDWORKS PDM data
vaults.

Microsoft SQL Server for
PDM Professional

Must be installed before new
vaults can be created.

Can be installed with
SOLIDWORKS PDM server
components when using
SLDIM.

Manages SOLIDWORKS PDM
licenses.

SolidNetWork License
Manager

Required. Install with PDM
Standard or Professional.

Manages transfers of files
between clients and the file
vault archive, and manages
users and their credentials.

Archive Server

Required. Install with PDM
Standard or Professional.

Polls PDM databases for
updates, manages data
import and export rules,
manages the message
system, and schedules
replication and cold storage.

Database Server
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InstallationFunctionServer

Optional. Install with PDM
Professional only.

Provides access to file vaults
over the Internet from
browser-based clients.

Web Server and Web2
Server

Archive servers run as services on the system account of the computers where they are
installed. One archive server can host multiple file vaults on the same computer.

In a standalone installation, the archive server, database server, and license server, as
well as the SQL Express or SQL Server database, can all be installed on the same machine.

In a distributed environment, the server components can reside on different machines.
Also, you can set up multiple archive servers on different computers to host replicated
copies of the same file vault archive. See the SOLIDWORKS PDM Professional Replication
Guide.

Before Installing PDM Server
Keep these requirements in mind before installing PDM server components:

• Obtain full administrative rights to the machines on which you are going to install
servers and clients.

• Ensure that the database server has access to the archive server over TCP port 3030
and to the SQL Server over TCP port 1433.

• If you are going to use an existing SQL Server Express or SQL Server database, obtain
the name of the SQL Server database and the account ID and password of a SQL Server
administrator or database owner with read/write access to the database. You cannot
use the tew user.

• If a PDM client is already installed on the system, uninstall it. If you want the PDM
Server and PDM Client on the same system, you can install them both from the Server
products page in the SOLIDWORKS Installation Manager.

Installing a PDM Server with SLDIM
When you install the PDM Server for PDM Standard, you can install the archive server,
the database server, and the PDM CAD Editor client on the same machine. You do not
need to run the client installation separately.

When installing the PDM Server for PDM Professional, you can include these components,
and also the Web server and Web2 server.

To install a PDM Server and its components:

1. Start the SOLIDWORKS Installation Manager.
2. On the Welcome page, select Server Products, check the following:

• Install SOLIDWORKS PDM Server components on this computer.
• Install SolidNetWork License Manager on this computer.

If the SolidNetwork License Manager is installed, this option does not display.
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3. If the SolidNetwork License Manager Options page displays, type a serial number and
specify a location for the directory, and click Next.

4. Follow instructions for system warnings and click Next.
5. On the Summary page, for SOLIDWORKS PDM Server, click Change.
6. In the SOLIDWORKS PDM Server Options page:

a) For Select Server Product, click SOLIDWORKS PDM Standard or Professional.
b) For Installation Location, click Browse to specify a file path.
c) In Select Features:

1. Click Archive Server, Database Server, and Client to install these components
on the same machine. If you are in a distributed environment, you can install
the archive server and database server by running the Installation Manager on
another machine.

If a PDM client is already installed on the machine, you must cancel the
installation and uninstall the client. You can then run the SLDIM to install the
PDM server with the client together.

2. If you are installing PDM Professional, you can also clickWeb server andWeb2
server.

d) In SQL Server, you can install a new instance of the database and management
tools that comes with PDM Server (SQL Server Express for PDM Standard), or you
can specify the database name, username, and password of an existing instance.

A full edition of SQL Server ships separately with PDM Professional.

e) Click Back to Summary.

7. On the Summary page, accept the terms of the SOLIDWORKS License Agreement
and click Install Now.

When the SOLIDWORKS Installation Manager completes installing, the Archive Server
Configuration Tool launches. Follow the prompts in the wizard to configure the archive
server.

To set up, configure, and troubleshoot the archive server, database server, Web and
Web2 servers, and SQL Server databases, see the relevant topics in the SOLIDWORKS
PDM 2016 Installation Guide.

Modifying a SOLIDWORKS PDM Server Installation

To modify an installation of SOLIDWORKS PDM Server and its components, use Programs
and Features from theWindows Control Panel. You cannot modify the installation with
SOLIDWORKS Installation Manager (SLDIM), even if that is what you used to install
SOLIDWORKS PDM Server.

78

SOLIDWORKS PDM



Understanding Differences between PDM Clients
Before installing the client software, you must determine what clients are needed
depending on your PDM environment.

This table summarizes the clients for SOLIDWORKS PDM Standard:

DescriptionStandard Client type

Supports working with SOLIDWORKS,
DWG/DXF format, Microsoft Word, and
Microsoft Excel files. All file formats, that
Office plug-in handles, behave in the same
way in SOLIDWORKS PDM Standard except
Preview.

CAD Editor

Supports working with SOLIDWORKS,
DWG/DXF format, Microsoft Word, and
Microsoft Excel files.

Contributor

Allows read-only access to file vaults. User
can transition files through a workflow, but
user cannot add or modify (check out, check
in, update values) files.

Viewer

This table summarizes the clients for SOLIDWORKS PDM Professional:

DescriptionProfessional Client type

Supports working with all file types,
including enhanced management and
previewing of CAD formats such as
SOLIDWORKS. CAD add-ins allow users to
access SOLIDWORKS PDM Professional from
within the CAD application. Remote users
can search vaults and perform basic
functions over the Internet using the Web
and Web2 clients.

CAD Editor & Web

Supports working with all file types,
including CAD files. However, the CAD
add-ins are not supported on this client
type. Remote users can search vaults and
perform basic functions over the Internet
using the Web and Web2 clients.

Contributor & Web

Allows read-only access to file vaults. User
can transition files through a workflow, user
cannot add or modify (check out, check in,
update values) files or use CAD add-ins.

Viewer
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Installing a PDM Client with SLDIM
To install a PDM Client:

1. Start the SOLIDWORKS Installation Manager.
2. On the Welcome page, select Individual.
3. On the Serial Number page, click Next.

SOLIDWORKS PDM clients do not require a separate serial number.

4. Follow instructions for system warnings and click Next.
5. On the Summary page, under Products, click Change.
6. On the Product Selection page, click Select different packages or products.
7. In the Select the package you want to show dialog box, select an edition of

SOLIDWORKS. Then click OK.
8. On the Product Selection page, select SOLIDWORKS PDM Client. Then select

eDrawings to enable the PDM Preview functionality. If you are using SOLIDWORKS
PDM Professional, you can also select Item Explorer.

9. On the Summary page, expand SOLIDWORKS PDM Options and click Change.
10. On the SOLIDWORKS PDM Client Options page, select the following and click Back

to Summary:

• PDM product type
• PDM client type
• Add-ins

11. On the Summary page, accept the terms of the SOLIDWORKS License Agreement
and click Install Now.

Administrators can also use the Administrative Image Option Editor to create and
deploy images of PDM clients. For details, see Using Administrative Images in the
SOLIDWORKS Installation and Administration Guide.
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6
SOLIDWORKS Electrical
The major components of SOLIDWORKS Electrical are:

• SOLIDWORKS Electrical Schematic - Tools for 2D dynamic electrical schematic creation.
• SOLIDWORKS Electrical 3D - Tools to integrate 2D schematics with 3D models, so you can
model electrical systems in 3D, including cables and wires.

• Data - A database of parts, symbols, libraries and catalogs that can be shared by users.
• Collaborative Server - A utility to manage the opening and updating of electrical drawings.
• An instance of the Microsoft SQL Server database.

SOLIDWORKS Electrical requires a Microsoft SQL Server database. It can use an existing
database, or a new instance as part of the installation.

You can install all SOLIDWORKS Electrical components on the same machine. This installation
is typically regarded as a standalone install. All program data, such as project drawings and
reports, are stored on a single system. Full administrative rights to the system are required
prior to installing SOLIDWORKS Electrical.

You can also install the SOLIDWORKS Electrical components as a client/server application.
This installation is required when data must be stored on a network server, or where there is
an existing SQL Server database on a network server that stores all the SOLIDWORKS Electrical
databases. In these cases, full administrative rights are required on both the server and client
systems. Also, client systems must have network access to the server and read/write privileges
for creating projects, libraries and symbols.

This chapter includes the following topics:

• Managing Data in SOLIDWORKS Electrical
• Requirements for Installing SOLIDWORKS Electrical

Managing Data in SOLIDWORKS Electrical
Many programs use a single database which contains all the program data. This is not
the case with SOLIDWORKS Electrical. Each project in SOLIDWORKS Electrical is assigned
a unique ID number, and every project has a related database that can be identified
based on its unique ID number. For example, in the SOLIDWORKS Electrical Project
Manager, if you find a project with ID#112, then the associated database is named
“tew_project_data_112.”

The reason for having a unique database for each project is that it significantly reduces
process time. Also, in the case of a critical database failure, only one project is affected,
retaining the integrity of the majority of the program information.

However, some companies have policies that restrict the creation of new
databases. To run SOLIDWORKS Electrical, there can be no restrictions on
creating new databases by users. Check with the system or database
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administrator to ensure that no configuration settings prevent users from
creating new databases.

Requirements for Installing SOLIDWORKS Electrical
To access current system requirements, see
http://solidworks.com/System_Requirements.

Individual and Server Options
You can install SOLIDWORKS Electrical in either individual or server mode.

It is important to note that SOLIDWORKS Electrical needs to connect to an instance of
SQL Server, whether it is an existing or a new instance.

In individual mode, you can install the following components:

• SOLIDWORKS Electrical Schematic
• SOLIDWORKS Electrical 3D
• Collaborative Server
• Data
• A new instance of the SQL Server database

In server mode, you can install the following components:

• A new instance of the SQL Server database
• Collaborative Server
• Data

You can combine components from individual and server modes to create a client/server
environment. For example, you can install SOLIDWORKS Electrical Schematic and
SOLIDWORKS Electrical 3D on client systems, and install all server components on a
server system.

Specifying the Data Location

For the data location, select a directory to store program data such as parts, templates,
and 2D and 3D symbols. This location should be a dedicated directory. It cannot be a
root directory or the same directory used to store SOLIDWORKS data.

The default directory is C:\ProgramData\SOLIDWORKS Electrical. A folder called Update
is added to the same directory to store all of the available program data.

When you launch SOLIDWORKS Electrical for the first time, the Update Data wizard
displays. In this wizard, you can select the data to be added into the application and
the SQL Server database.

Configuring the Collaborative Server

To run SOLIDWORKS Electrical, you must install the Collaborative Server on the same
system that hosts the Microsoft SQL Server database.
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The Collaborative Server must be running at all times, and have constant, uninterrupted,
bidirectional communication with clients through firewalls and virus scanners.

To install the Collaborative Server either in individual or server mode, you must specify
the following parameters:

• The machine name, such as LOCALHOST
• The IP address of the machine, such as 127.0.0.1
• The port number, such as 26666

To provide uninterrupted bidirectional communication, make sure that port number 26666
is available on the system where the Collaborative Server is installed. If port 26666 is
not accessible, work with the system administrator to find another port that can be
accessed by SOLIDWORKS Electrical.

Configuring Microsoft SQL Server

You must insure that an instance of the SQL Server database is available for any type of
SOLIDWORKS Electrical installation. You can use an existing SQL Server database if it is
already installed on the system, or install a new instance as part of the SOLIDWORKS
Electrical installation.

When you install a new instance of SQL Server, SOLIDWORKS installation provides a free
version of Microsoft SQL Server Express. This version is limited to 1 CPU, 1 GB of memory,
and 10 GB of data. The memory and CPU limitations are sufficient to support 5 concurrent
users.

If you install SQL Server Express Edition, ensure that the server software and hardware
meet the requirements listed http://solidworks.com/System_Requirements.

However, if there are more 6 or more concurrent users on the same server, you should
purchase and install a full version of SQL Server, and use the workflow described for
installing SOLIDWORKS Electrical with an existing instance of SQL Server.

For information about the SQL Server Express Edition, consult the Microsoft SQL Server
documentation.

New Instances of SQL Server

If you install a new instance of SQL Server, you need full administrative rights to the
server, and also to any client systems. You must also ensure that clients have read/write
privileges for the database, so they can create and modify projects, libraries, symbols
and other project data.

When you install a new instance of SQL Server, select a name other than the default.

Existing Instances of SQL Server

You need a user account that has full administrative rights to the SQL Server database
to install new SOLIDWORKS Electrical databases or to connect to a SOLIDWORKS Electrical
installation on an existing instance of SQL Server.

For SOLIDWORKS Electrical to function properly, you must enable SQL Server for mixed
mode authentication. Mixed mode authentication allows the use of either Windows or
SQL Server credentials.
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To connect to an existing SQL Server database, you can use Windows or SQL Server
authentication. Enter a user name and password for a Windows or SQL Server login that
has full SQL Server administrative rights.

You cannot use the ‘tew’ user to connect to SQL Server for installation. Contact your SQL
Server administrator or system administrator for help to obtain a login with the proper
credentials for SQL Server.

Post Installation of SQL Server

After SOLIDWORKS Electrical is installed, the SQL Server instance creates the following
databases in SOLIDWORKS Electrical:

• TEW_APP_DATA
• TEW_APP_MACRO
• TEW_APP_PROJECT
• TEW_CATALOG
• TEW_CLASSIFICATION
• TEW_SQLEXPRESS
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7
License Administration
Typically, installations on individual computers use license activation; however, you can install
the software individually and then control the licenses with SolidNetWork License Manager.
Conversely, although larger sites typically use floating network licenses, you can deploy the
installations from an administrative image and then activate the serial numbers from the
individual computers.

If you are running Windows 8, see Tips for Using SOLIDWORKS with Microsoft Windows 8
for tasks such as accessing Start or the Control Panel. These steps may vary depending
on how Windows 8 is configured on your system. Consult Microsoft Windows documentation
for additional instructions and options.

This chapter includes the following topics:

• Administering Individual Licenses
• Administering Licenses Using a SolidNetWork License Manager

Administering Individual Licenses
Typically, administration of individual licenses consists of activating and deactivating
licenses directly from SOLIDWORKS.

Activation is a product licensing and registration process for SOLIDWORKS standalone
(non-SolidNetWork License) licenses. Typically, if your product license has not yet been
activated, SOLIDWORKS tries to activate it when you start the product.

You can also deactivate individual licenses, by clicking Help > Deactivate Licenses in
SOLIDWORKS.

Activating a License
Before you can run SOLIDWORKS products on an individual computer, you must activate
the license for that computer.

Activation requires that you have Internet or email access. After activation, you do not
need to be online to use the products. If you do not have email access on the computer
where you use this product, you can save the activation file and send it from another
computer.

This process:

• Activates all software licenses across the SOLIDWORKS product line.
• Allows you to move licensing rights from one computer to another.
• Can be performed immediately (recommended) or within 30 days of installation.
• Eliminates the need for dongles. However, if you run previous versions of SOLIDWORKS
products that do not use activation, you need to retain the dongle.
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For system administrators who have multiple serial numbers to manage, you can use the
Administrative Image Option Editor. For details, see Administrative Image Option Editor.

To activate a license:

1. Start the SOLIDWORKS application.
2. Start SOLIDWORKS Product Activation using one of these methods:

• If you have not yet activated the license for this computer, the SOLIDWORKS
Product Activation window appears automatically when you start SOLIDWORKS.

• If the SOLIDWORKS Product Activation window does not appear automatically,
start activation by clicking Help > Activate Licenses.

3. Click the Product listing to specify the product whose license you want to activate.
4. Specify automatic activation over the internet or manual activation using email.
5. Supply email contact information.
6. Click Next to proceed.

• Internet: Activation occurs automatically.
• Email: Press Save to create a request file, then email the file to

activation@solidworks.com. When you receive the email containing the response
file, extract the file from email and then click Open to load it.

If necessary, you can exit and rerun the activation procedure to open the
response file.

7. Click Finish.

Moving a License
To move a license to a new or upgraded computer, first deactivate it to the license key
server at Dassault Systèmes SOLIDWORKS Corporation, then reactivate it on the other
computer.

If you were unable to deactivate the license to Dassault Systèmes SOLIDWORKS
Corporation (because of hard drive failure, for example), reactivation is still successful
in most cases. If not, contact your VAR for help.

To move a license back to the server:

1. In SOLIDWORKS, click Help > Deactivate Licenses, and follow the instructions.
2. To reactivate, go to the new or upgraded computer and activate the license as you

did during the initial activation. For details, see Activating a License.

Administering Licenses Using a SolidNetWork License
Manager

SolidNetWork License Manager supports multiple license clients by distributing licenses
to clients on the network. This allows the number of users to exceed the number of
licenses by using floating licenses.

This image depicts a typical SolidNetWork licensing installation:
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This image illustrates:

• SolidNetWork License Manager software is installed and activated on the license manager
computer only.

• License client computers do not have any additional SolidNetWork-specific software
installed.

If you specify a SolidNetWork License serial number when installing, SOLIDWORKS
Installation Manager identifies that computer as a SolidNetWork license client.
SOLIDWORKS Installation Manager prompts you for the SolidNetWork license manager
computer name and port number to connect the client to the license manager.

• The license manager and all license clients must have TCP/IP (Transmission Control
Protocol/Internet Protocol) connectivity.

Activating a SolidNetWork License
Before users can run SOLIDWORKS products on their individual computers, you must
activate a SolidNetWork license on the SolidNetWork License Manager computer.

Activation requires that you have Internet or email access. After activation, you do not
need to be online to use the products. If you do not have email access on the computer
where you use this product, you can save the activation file and send it from another
computer.

This process:
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• Activates the SOLIDWORKS SolidNetWork License Manager with SolidNetWork licenses
across SOLIDWORKS products.

• Allows you to move SolidNetWork licensing rights from one SolidNetWork License
Manager computer to another.

• Enables you to install and activate the SolidNetWork licensing rights on one SolidNetWork
License Manager computer.

• Must be performed before you can use SolidNetWork licenses.
• Eliminates the need for dongles. If you activate a SolidNetWork license for this version
of SOLIDWORKS, SolidNetWork licenses for previous versions of SOLIDWORKS are
activated. (You no longer need to retain the dongle.)

To activate a SolidNetWork license:

1. Start the SolidNetWork License Manager (Start > Programs > SOLIDWORKS
version > SolidNetWork License Manager > SolidNetWork License Manager).

2. If you have not yet activated the SolidNetWork license, you are asked whether you
want to activate it now. Click Yes to activate.

3. Under How would you like to activate?, select Automatically over the internet
(recommended).

4. Under Contact Information, specify an email contact address.

The Activation/Reactivation Succeeded dialog box displays the products that have been
activated.

Moving a SolidNetWork License
To move a SolidNetWork license to a new or upgraded computer, first deactivate the
license to the license key server at Dassault Systèmes SOLIDWORKS Corporation, then
reactivate it on the other computer.

If you were unable to deactivate the license to Dassault Systèmes SOLIDWORKS
Corporation (because of hard drive failure, for example), reactivation is still successful
in most cases. If not, contact your VAR for help.

To move a SolidNetWork license back to the server:

1. Start SolidNetWork License Manager (Start > Programs > SOLIDWORKS version
> SolidNetWork License Manager > SolidNetWork License Manager).

2. Under License Information, click Modify. The SOLIDWORKS Product Activation
wizard starts.

3. Under What would you like to do?, select Deactivate a software license and
then click Next.

4. Under Howwould you like to deactivate?, select Automatically over the internet
(recommended).

5. Under Contact Information, specify an email contact address.
6. Click Next. The deactivation of the product license completes.
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Installing and Configuring SolidNetWork Licensing
Configuring SolidNetWork Licensing consists of installing the SolidNetWork License Manager
on the license manager computer and then installing SOLIDWORKS on client computers
using the SolidNetWork license serial number.

Installing and Activating a License Manager
The SolidNetWork License Manager supports multiple license clients. It distributes licenses
to clients on the network.

If you are upgrading from a previous version of SolidNetWork License Manager that used
hardware dongles for license activation, remove the hardware dongle before installing
the new version of SolidNetWork License Manager.

1. Start SOLIDWORKS Installation Manager (as described under Initiating SOLIDWORKS
Installation).
a) For type of installation, select the following:

• Server products
• Install SolidNetWork License Manager (distributed licensing) on this
computer.

b) On the SolidNetWork License Manager Options page, specify the SolidNetWork
License serial number and SolidNetWork License Manager installation location.

c) On the Summary page, click Install Now to complete the SOLIDWORKS Installation
Manager process.

2. To activate SolidNetWork licensing:
a) Start SolidNetWork License Manager (Start > Programs > SOLIDWORKS version
> SolidNetWork License Manager > SolidNetWork License Manager).

b) When prompted to activate, click Yes.
c) On the SolidNetWork License Server Information screen:

• If your company uses a firewall, select A firewall is in use on this server.

For more information, see Using SolidNetWork Licenses with Firewalls.
• Use the default value for Port Number (and for Vendor Daemon Port Number
if you have a firewall) or specify the port numbers your company uses.

The port number is a TCP/IP port number in the 1024-60000 range, used
exclusively by this process. Normally, the default (25734) is suitable and is
unlikely to be the same as any other FLEXnet server process currently on the
license manager computer.

d) On the Activate Your SOLIDWORKS Product screen:

• Select the Internet or email procedure.
• Supply email contact information.
• Click Next to proceed.
• Internet: Activation occurs automatically.
• Email: Press Save to create a request file, then send the file to
activation@solidworks.com. When you receive the email containing the
response file, extract the file from email and then click Open to load it.
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If necessary, you can exit and rerun the activation procedure to open the
response file.

3. Click Finish.

Installing a License Client
When installing SOLIDWORKS on SolidNetWork License Client computers, the serial
number identifies that computer as a SolidNetWork License Client.

1. Start SOLIDWORKS Installation Manager (as described under Initiating SOLIDWORKS
Installation).

2. On the Welcome screen click Individual (on this computer) if this is the first
SOLIDWORKS installation on this computer for this major release.

If you are upgrading from an existing release, and are changing from individual
licensing to SolidNetWork licensing, click Modify the individual installation (on
this computer). For details, see Upgrading from Individual Licensing to
SolidNetWork Licensing.

3. When prompted for a serial number, enter the SolidNetWork License serial number.
4. In the Add Server dialog box, type the SolidNetWork License Manager's address in

the form:

port@ComputerName

The port number must be the same one used for the license manager computer. The
default is 25734 (as described in Installing and Activating a License Manager).

SOLIDWORKS Installation Manager will attempt to validate that this SolidNetWork
License Manager is accessible. If you have not yet installed a license manager, this
validation will fail; however, you still can proceed with the license client installation.

5. Complete the SOLIDWORKS installation by following the SOLIDWORKS Installation
Manager instructions.

Install SolidNetWork License Managers Before Installing License
Clients
You should install and configure SolidNetWork License Manager on at least one computer
prior to installing any SolidNetWork license client computers.

When installing with a SolidNetWork License serial number, SOLIDWORKS Installation
Manager prompts you to enter the SolidNetWork License Manager computer name and
port number, and then attempts to validate that information.

If you have not yet installed SolidNetWork License Manager on the computer you specified,
this validation cannot succeed. However, in this case validation failure does not indicate
whether you have supplied correct license manager information. If the license manager
is installed, validation failures indicate that you have specified incorrect license manager
information.
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Managing Access to SOLIDWORKS Versions
You can restrict users from using specific versions of SOLIDWORKS in a SolidNetWork
environment. This capability allows you to manage the versions of SOLIDWORKS used
by different individuals, projects, and business units.

To manage access to SOLIDWORKS versions using a a FLEXnet options file:

1. In the SolidNetwork License Manager installation directory, create a text file:
SolidNetWork_License_Manager_install_dir\Licenses\sw_d.opt

2. To manage access to a specific SOLIDWORKS version in the license file, add the
following syntax next to SOLIDWORKS:

where xx is the version of the
SOLIDWORKS product you want to
manage

:SWVERSION=xx

3. To manage multiple versions of SOLIDWORKS, add a line for each version you want
to manage.

Not all FLEXnet options are supported. The supported options for version filters are:

Only allow the user or group the ability to
start the specific version. All other users
will not be allowed to start that version.

INCLUDE

Only allow the user or group the ability to
borrow the specific version. All other users
will not be allowed to borrow that version.

INCLUDE_BORROW

Prohibit the listed user or group from
starting the specific version of
SOLIDWORKS. EXCLUDE supersedes
INCLUDE.

EXCLUDE

Prohibit the listed user or group from
borrowing the specific version of
SOLIDWORKS. EXCLUDE supersedes
INCLUDE.

EXCLUDE_BORROW

Examples:

SWVERSION=24.0 refers to SOLIDWORKS 20161

SWVERSION=23.0 refers to SOLIDWORKS 2015

INCLUDE solidworks:SWVERSION=24.0 USER jane2

INCLUDE_BORROW solidworks:SWVERSION=24.0 USER jane
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These lines in the options file would allow only jane to run or SOLIDWORKS
2016. All other users cannot run or borrow SOLIDWORKS 2016, but they
can run and borrow other versions of SOLIDWORKS. jane can also run and
borrow other versions of SOLIWORKS.

GROUP chicago USER john robert eva3

EXCLUDE solidworks:SWVERSION=24.0 GROUP chicago

EXCLUDE solidworks:SWVERSION=23.0 GROUP chicago

EXCLUDE solidworks USER don

These lines define a GROUP of users called chicago and denies them access
to both SOLIDWORKS 2015 and SOLIDWORKS 2016, but they can run any
other version of SOLIDWORKS. User don cannot run any version of
SOLIDWORKS.

EXCLUDE swinspection_std:SWVERSION=24.0 HOST machine14

This line prohibits anyone on machine1 from launching SOLIDWORKS
Inspection 2016. Any use machine1 can run another version of
SOLIDWORKS Inspection 2015.

For more information about FLEXnet, see the FLEXnet Publisher License Administration
Guide in the SolidNetwork License Manager installation directory (\Docs\flexuser\
licensingenduserguide.pdf).

Triad License Manager Installation
Triad license managers use three computers for extra stability. If the computer managing
the license file is not available, one of the other two computers takes over.

Requirements for using triad license managers:

• Install triad license managers only on stable computers not scheduled for frequent
shutdowns.

• The three license manager computers should be on the same subnet. Never configure
triad license managers with slow communications or dial-up links.

• The system administrator should detect when a license manager computer goes down
and should restart it as soon as possible.

If only two license manager computers are running, the situation is worse than a
single license manager computer, because there are two points of failure.

92

License Administration



Installing the Initial Triad License Manager
Triad license managers use three computers for extra stability. This process shows how
to install SolidNetWork License Manager on the first computer in the triad.

1. On the first triad license manager computer, install the SolidNetWork License Manager
using SOLIDWORKS Installation Manager:
a) Start SOLIDWORKS Installation Manager (as described under Initiating

SOLIDWORKS Installation).
b) For type of installation, select the following:

• Server products
• Install SolidNetWork License Manager (distributed licensing) on this
computer.

c) On the SolidNetWork License Manager Options page, specify the SolidNetWork
License serial number and SolidNetWork License Manager installation location.

d) On the Summary page, click Install Now to complete the SOLIDWORKS Installation
Manager process.

2. Using the SolidNetWork License Manager, configure the initial triad license manager
computer:
a) Start SolidNetWork License Manager (Start > Programs > SOLIDWORKS version
> SolidNetWork License Manager > SolidNetWork License Manager).

b) Click No.
The Server Administration tab of the SOLIDWORKS SolidNetwork License Manager
appears.

c) Under Advanced Options, click Options.
The Advanced Options dialog box appears.

d) Under SolidNetWork Server License Mode, click Use a License File and click OK.
The Advanced Options dialog box closes.

e) Under License Information, click Modify.
The SolidNetWork License File Wizard appears.

f) Under Server Type, select Triad and click Next.
g) On the Server Information pane, verify that the computer name, dongle ID, and
port number for the initial triad license manager computer are correct, and click
Next.

If the server uses an Network Interface Card (NIC) address instead of a dongle,
check that the NIC address matches the information in the license file received
from SOLIDWORKS, and that the port number for the triad license manager
computer are correct. The NIC address is also referred to as the MAC (Media
Access Control Address) address. Then click Next.

To find the NIC address, open a Command Prompt window and type:

ipconfig /all

Also, if your computer uses a firewall, you might have to make some additional
specifications on this screen. For more information, see Using SolidNetWork
Licenses with Firewalls.
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h) On the Triad Partner Server Information screen, enter the computer name and
dongle ID values for the other two triad license manager computers. If the
computers use NIC addresses, enter the computer name and Host ID values.

This ensures that if one license manager is unavailable, client computers can
get a license from the other two servers.

i) On the Licenses screen, click Read to browse to and open the SolidNetWork license
file.
The licenses appear in the SolidNetWork License File wizard.

j) Click Finish.
k) Click OK to exit the SolidNetWork License File wizard and then Finish to exit the
SolidNetWork License Manager.

Installing the Triad License Manager on Subsequent Computers
Triad license managers use three computers for extra stability. This process shows how
to install SolidNetWork License Manager on the second and third computers in the triad.

It is assumed that you already have installed at least one triad license manager on another
computer.

1. On the triad license manager computer, install the SolidNetWork License Manager
using SOLIDWORKS Installation Manager:
a) Start SOLIDWORKS Installation Manager (as described under Initiating

SOLIDWORKS Installation on page 10).
b) For type of installation, select the following:

• Server products
• Install SolidNetWork License Manager (distributed licensing) on this
computer.

c) On the SolidNetWork License Manager Options page, specify the SolidNetWork
License serial number and SolidNetWork License Manager installation location.

d) On the Summary page, click Install Now to complete the SOLIDWORKS Installation
Manager process.

2. Using the SolidNetWork License Manager, configure the triad license manager
computer:
a) Start SolidNetWork License Manager (Start > Programs > SOLIDWORKS version
> SolidNetWork License Manager > SolidNetWork License Manager).
Since this is the first time you are running the SolidNetWork License Manager on
this computer, you are asked whether you would like to activate now.

b) Click No.
The Server Administration tab of the SOLIDWORKS SolidNetwork License Manager
appears.

c) Under Advanced Options, click Options.
The Advanced Options dialog box appears.

d) Under SolidNetWork Server License Mode, click Use a License File and click OK.
The Advanced Options dialog box closes.
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e) Under License Information, click Modify.
The SolidNetWork License File Wizard appears.

f) Under Server Type, select Triad and Synchronize server/license information
and then click Next.

g) On the Server Information pane, verify that the computer name, dongle ID, and
port number for this triad license manager computer are correct, and click Next.

If the server uses an Network Interface Card (NIC) address instead of a dongle,
check that the NIC address matches the information in the license file received
from SOLIDWORKS, and that the port number for the triad license manager
computer are correct. The NIC address is also referred to as the MAC (Media
Access Control Address) address. Then click Next.

To find the NIC address, open a Command Prompt window and type:

ipconfig /all

Also, if your computer uses a firewall, you might have to make some additional
specifications on this screen. For more information, see Using SolidNetWork
Licenses with Firewalls on page 95.

h) If the computers use dongles, on the Triad Partner Server Information screen,
enter the computer name and dongle ID values for the other two triad license
manager computers. If the computers use NIC addresses, enter the computer
name and Host ID values.

This ensures that if one license manager is unavailable, client computers can
get a license from the other two servers.

i) On the Licenses screen, click Read to browse to and open the SolidNetWork license
file.

Typically, the licenses file is located on \licenses\sw_d.lic on the first triad
license manager computer you configured.

The licenses appear in the SolidNetWork License File wizard.
j) Click Finish.
A SolidNetWork License File Wizard warning appears.

k) Click OK to exit the SolidNetWork License File wizard and then Finish to exit the
SolidNetWork License Manager.

If you are configuring the second triad license manager computer, repeat this process
for the third triad license manager computer.

Using SolidNetWork Licenses with Firewalls
If your computer uses a firewall, you must configure ports to support SolidNetWork
Licensing.

In the firewall software, you must add two SolidNetWork License ports (for example,
SNL-in-port and SNL-out-port) to the firewall exceptions list. For details about
configuring these ports, consult with your system administrator.
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If you are using Windows Firewall on a supported Windows operating system, you must
modify ports on the SolidNetWork license manager computer and modify the SolidNetWork
license file to distribute licenses to the license client computers.

Modifying License Manager Computer Ports for Windows Firewall
If you are using Windows Firewall, you must modify firewall port settings on the
SolidNetWork license manager computer.

1. In Windows, open the Control Panel and then double-click Security Center.
2. Click Windows Firewall.
3. On the Exceptions tab, click Add Port.
4. Type a Name (for example, SNL-in-port) and a Port Number (for example, 25734)

and then click OK.
5. For the second port, click Add Port on the Exceptions tab again, specify the other

port's name and number (for example, SNL-out-port and 25735), and then click OK.
Note the port number, as you will reference it later when modifying the SolidNetWork
license file.

If you use Workgroup PDM, you must modify Workgroup PDM port numbers in
Windows Firewall. Typically, these ports are 20000 (VaultAdmin), 30000 (Data),
40000 (Request), and 80 (Viewer).

6. Close Windows Security Center and Control Panel.

Modifying SolidNetWork License Manager Settings for Windows
Firewall
If you are using Windows Firewall, you must modify the SolidNetWork license file to use
the firewall ports to distribute licenses to the license client computers.

1. Start SolidNetWork License Manager (Start > Programs > SOLIDWORKS version
> SolidNetWork License Manager > SolidNetWork License Manager).

2. On the Server Administration tab, under License Server, click Stop. (Click Yes when
prompted for confirmation and OK to complete stopping the license server.)

3. Under License Information, click Modify.
4. Under Server Type, select the server arrangement for your network (Single or

Triad) and then click Next.
5. Under Server Information:

a) Select A firewall is in use on this server.
b) Port Number and Vendor Daemon Port Number should contain the port numbers
specified for the Windows Firewall (for details, see Modifying License Manager
Computer Ports for Windows Firewall).
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c) Select Options File and click Browse to locate the file. Click Edit to change any
of its parameters.

The options file allows the license administrator to control various operating
parameters of FLEXnet Licensing.

The recommended location for the options file is in the SolidNetwork License
Manager installation directory (SolidNetwork_License_Manager_install_dir\
Licenses \sw_d.opt). This file must in the same directory as the sw_d.lic
file.

For more information about the options file, see the FLEXnet Publisher License
Administration Guide in the SolidNetwork License Manager installation directory
(\Docs\flexuser\licensingenduserguide.pdf).

d) Click Next and then click Finish.

6. On the Server Administration tab, under License Server, click Start.
7. Click OK to close the SolidNetWork License Manager.

SolidNetWork License Administration
Tasks include starting, upgrading, and uninstalling the license manager, and borrowing
and returning licenses.

Before you start or upgrade the license manager, you must return any borrowed
licenses.

Starting the SolidNetWork License Manager
You can start the SolidNetWork License Manager from the Windows Start menu.

In Windows, run this command: Start > Programs > SOLIDWORKS version >
SolidNetWork License Manager > SolidNetWork License Manager.

Upgrading the SolidNetWork License Manager
For major releases of SOLIDWORKS, upgrading the license manager consists of uninstalling
the old license manager, installing a new one, and re-activating the SolidNetWork license.

The license manager for a newer release can distribute licenses for client computers
remaining at the previous release as well.

1. Start SolidNetWork License Manager (Start > Programs > SOLIDWORKS version
> SolidNetWork License Manager > SolidNetWork License Manager).

2. On the License Usage tab, verify that no client computers on the network are running
SOLIDWORKS.

3. Uninstall the old license manager. For details, see Uninstalling the SolidNetWork
License Manager.

4. Install the new license manager and re-activate the SolidNetWork license on the
license manager computer. For details, see Installing and Activating a License
Manager on page 89.
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If you are upgrading the SolidNetWork License Manager on a computer that also runs the
SOLIDWORKS application, upgrade SolidNetWork license managers and clients before
installing any new SOLIDWORKS application service packs on that computer.

If you are upgrading the license manager on a computer that hosts administrative images,
upgrade the license manager before upgrading the administrative images. For details,
see Using the Same Computer for the License Manager and Administrative Image
Installations.

Uninstalling the SolidNetWork License Manager
When upgrading the SolidNetWork License Manager, you must uninstall the old license
manager before installing the new one.

1. Start SolidNetwork License Manager (Start > Programs > SOLIDWORKS version
> SolidNetWork License Manager > SolidNetWork License Manager).

2. Verify that no client computers on the network are running SOLIDWORKS.
The License Usage tab shows clients running SOLIDWORKS.

3. If you wish to move the SolidNetWork license to another computer, deactivate the
license to that computer before removing the SolidNetWork License Manager.

For information about moving SolidNetWork licenses, see Moving a SolidNetWork
License.

4. On the Server Administration tab, under License Server, click Stop.
5. Click OK to exit the license manager.
6. In Windows, open Control Panel > Add or Remove Programs.
7. Select SOLIDWORKS SolidNetWork License Manager, click Remove, and confirm

the deletion.
8. In Windows Explorer, delete the SOLIDWORKS SolidNetWork License Manager folder.

(Typically, this folder is located under Program Files in the SOLIDWORKS installation
directory.)

You now are ready to install a new version of the license manager. For details, see
Installing and Activating a License Manager.

If the SolidNetWork License Manager computer has a hardware dongle attached, remove
the hardware dongle before installing the new version of SolidNetWork License Manager.

Deleting SolidNetWork License Files
Delete old and expired SolidNetWork license files before upgrading to new ones.

1. Start SolidNetWork License Manager (Start > Programs > SOLIDWORKS version
> SolidNetWork License Manager > SolidNetWork License Manager).

2. On the Server Administration tab, under License File, click Modify, and then click
Next until you reach the Licenses screen.

3. On the Licenses screen, select the old or expired SolidNetWork license file, then click
Remove.

4. Click Finish and then click OK.
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Borrowing and Returning SolidNetWork Licenses
You can borrow a SolidNetWork license to use the software from a remote location. Since
the license is removed from the pool of available licenses, a borrowed license must be
returned for it to become available again.

Borrowed licenses are valid only for the current user and machine on which they were
borrowed; they cannot be moved.

The license is lent for a specified period of time, up to 30 days (or as defined by the
system administrator), and the license is removed from the pool of available licenses.

System administrators can customize borrowing to:

• Define users or groups that are allowed to borrow licenses
• Set the number of licenses that cannot be borrowed

For details, see SolidNetWork_License_Manager_install_dir\Docs\flexuser\
licensingenduserguide.pdf.

Borrowing SolidNetWork Licenses
You can borrow a SolidNetWork license to use the software from a remote location.

You must be connected to the SolidNetWork license manager to borrow the license, but
not necessarily to use it.

If you are running Windows 8 or later, these steps vary depending on your
system configuration. Consult Microsoft Windows documentation for
additional instructions and options.

1. Start SolidNetWork License Manager on the client machine (Start > Programs >
SOLIDWORKS version > SolidNetWork License Manager > SolidNetWork
License Manager).

2. On the License Borrowing tab:
a) Select a date in Borrow until.
b) Select the products to borrow, then click Borrow, and click Yes to confirm.
c) Click Refresh. The Expire Date column indicates when licenses are due back.

3. Click OK.

Returning a Borrowed SolidNetWork License
Since a borrowed SolidNetWork license is removed from the pool of available licenses,
that borrowed license must be returned for it to become available again.

1. Start SolidNetWork License Manager (Start > Programs > SOLIDWORKS version
> SolidNetWork License Manager > SolidNetWork License Manager).

2. On the License Borrowing tab:
a) Select the products to return, click Return, and then click Yes to confirm.
b) Click Refresh. The Expire Date column becomes blank, indicating that the licenses
have been returned.

3. Click OK.
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It is not necessary to return licenses after the expiration date. The license is returned
to the pool on the SolidNetWork license manager at midnight on the expiration date
and the applications on the remote system no longer run.

Monitoring License Idle Time
SOLIDWORKS can register idle time with the SolidNetWork License Manager so that
licenses that have not been used for a certain amount of time are returned to the free
license pool.

1. In the SolidNetwork License Manager installation directory, create a text file:
SolidNetWork_License_Manager_install_dir\Licenses\sw_d.opt

2. Add the following line to the file:
TIMEOUTALL seconds

where seconds is a number greater than or equal to 900 (15 minutes), which is the
minimum time allowed.

Installing Temporary Licenses
The temporary "ANY" license can be used temporarily when the original SolidNetWork
license is not available.

By installing the "ANY" license file, you agree to implement the traditional license upon
receipt of a SolidNetWork license from Dassault Systèmes SOLIDWORKS Corporation.
Compliance with license restrictions still is required.

To install an "ANY" license:

1. If you are an existing SolidNetWork user, uninstall the SolidNetWork License Manager
and delete the installation folder. For details, see Uninstalling the SolidNetWork
License Manager on page 98.

2. Start SOLIDWORKS Installation Manager (as described under Initiating
SOLIDWORKS Installation on page 10).
a) For type of installation, select the following:

• Server products
• Install SolidNetWork License Manager (distributed licensing) on this
computer.

b) On the SolidNetWork License Manager Options page, specify the SolidNetWork
License serial number and SolidNetWork License Manager installation location.

c) On the Summary page, click Install Now to complete the SOLIDWORKS Installation
Manager process.

3. Start SolidNetWork License Manager (Start > Programs > SOLIDWORKS version
> SolidNetWork License Manager > SolidNetWork License Manager).

4. If you are prompted to activate, click No.
The Server Administration tab of the SOLIDWORKS SolidNetwork License Manager
appears.
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5. Under Advanced Options, click Options.
The Advanced Options dialog box appears.

6. Under SolidNetWork Server License Mode, click Use a License File and click OK.
The Advanced Options dialog box closes.

7. Under License Information, click Modify.
The SolidNetWork License File Wizard appears.

8. Under Server Type, select Single and click Next.
9. When you see this message:

Could not read the dongle ID number. click Cancel.

The ID "ANY" appears automatically.

If your computer uses a firewall, you might have to make some additional
specifications on this screen. For more information, see Using SolidNetWork
Licenses with Firewalls on page 95.

10. Continue with the installation.

Upgrading from Individual Licensing to SolidNetWork Licensing
You can upgrade a computer from individual SOLIDWORKS licensing to SolidNetWork
licensing by specifying the SolidNetWork license serial number in SOLIDWORKS Installation
Manager.

If a computer does not have SOLIDWORKS installed, you can specify SolidNetWork
licensing by entering the SolidNetWork serial number when installing with SOLIDWORKS
Installation Manager.

If a computer already has SOLIDWORKS installed and you are switching from individual
licensing to SolidNetWork Licensing, you can modify the installation for the client computer
and specify the SolidNetWork License serial number in place of the individual license serial
number when running SOLIDWORKS Installation Manager. For details, see Modifying an
Installation.

If you installed SOLIDWORKS from an administrative image, the modify option is not
available. You must make changes to the administrative image using the Administrative
Option Editor, uninstall the client, and rerun the installation.

Using SolidNetWork Licenses with Add-in Products
You can use the SolidNetWork License Manager to distribute licenses for SOLIDWORKS
core add-in products (such as FeatureWorks and Workgroup PDM Server).

• An equal number of SOLIDWORKS software licenses and SOLIDWORKS add-in licenses
are not required.

• To check out a license for an add-in product, you first must check out a license for
SOLIDWORKS.

• To borrow an add-in product license, you must borrow both the SOLIDWORKS software
license and the SOLIDWORKS product license that includes the add-in. A SOLIDWORKS
Standard license will be borrowed by default, but to enable an add-in, you will have to
borrow a SOLIDWORKS Professional or SOLIDWORKS Premium product license.

• To release an add-in product license:
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In SOLIDWORKS, click Tools > Add-ins and clear the add-in.•
• Exit SOLIDWORKS.

Using the Same Computer for the License Manager and
Administrative Image Installations
You can configure one computer on a network to act both as a license manager distributing
SolidNetWork licensing and as an administrative image location from which users can
install SOLIDWORKS software.

Client computers can obtain licenses from the license manager and then install
SOLIDWORKS from the same computer.

This configuration requires that the license manager and administrative image be
installed on the same computer. Install the license manager first and then create and
deploy the administrative image.

For details, see:

• Installing and Activating a License Manager on page 89
• Deploying to Multiple Clients on page 19

FLEXnet Publisher License Management
SolidNetWork Licensing is based on FLEXnet Publisher® license management.

For more information about FLEXnet Publisher license management, see the FLEXnet
Publisher License Administration Guide in the SolidNetwork License Manager installation
directory (\Docs\flexuser\licensingenduserguide.pdf).

For the latest information about FLEXnet Publisher license management, contact Acresso®
Software.
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8
Troubleshooting

This chapter includes the following topics:

• Network License Usage
• SOLIDWORKS Installation Manager Log Files
• SOLIDWORKS Installation Manager Download Folder
• Troubleshooting SolidNetWork Licenses
• Troubleshooting Upgrades
• Validating Your Graphics Card When Installing or Upgrading

Network License Usage
This dialog box opens when the server is out of licenses for a product.

Click the arrow in the Product box to display all the product choices. The choices include
SOLIDWORKS and all purchasable add-ins.

Total number of licences is the total number of licenses you have purchased.

Free licenses is the number of licenses that are not currently in use.

The Licenses used by box gives you information about each person currently using a
license.

SOLIDWORKS Installation Manager Log Files
SOLIDWORKS Installation Manager log files are available to assist you in troubleshooting
installation problems.

These log files are located with the other SOLIDWORKS application log files.

• For Windows 7 or later:

C:\Users\username\AppData\Roaming\SOLIDWORKS\Installation Logs\
installed_version

To see the log file directories, you might have to configure the Windows Folder options
to Show hidden files and folders.

If the application data is located on a drive other than C:, adjust the directory path
accordingly.

This directory contains the SummaryIMLog_nnnnn_nnnnn_nnnn_nnnnn.txt file, a general
log of SOLIDWORKS Installation Manager progress.

The Other Logs subdirectory contains more detailed installation log information.
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SOLIDWORKS Installation Manager Download Folder
SOLIDWORKS Installation Manager can download the installation files it needs to a folder
that you specify. This topic provides answers to frequently asked questions about the
download folder.

If you are running Windows 8 and later, refer to Tips for Using SOLIDWORKS with
Microsoft Windows 8 for tasks such as accessing Start or the Control Panel. These
steps may vary depending on how Windows 8 is configured on your system. Consult
Microsoft Windows documentation for additional instructions and options, especially
for systems later than Windows 8.

AnswerQuestion

Run setup.exe. You may still be required to download
some files if you select to install items that were not
downloaded previously.

Do not install using msiexec (see below).

How do I install the files in
this folder?

No. The Installation Manager does not download some files
that would be required when running msiexec.

Can I install MSI files
manually from this folder
using msiexec or some other
application?

Download folders are version-specific. Starting in
SOLIDWORKS 2010, SOLIDWORKS Installation Manager
automatically creates a version-specific sub-folder within
the specified folder.

Can I select the same
download folder for each
version I install?

Starting in SW2009, files downloaded manually can be
used by SOLIDWORKS Installation Manager. However, it
is better to run SOLIDWORKS Installation Manager,
selecting the option to download files. SOLIDWORKS
Installation Manager shows which files you need based on
what you are installing, providing links to download each
file. This option can be used when the built-in download
page does not work (most likely because of downloading
restrictions enforced by a proxy server).

If Microsoft Internet Explorer asks whether you want to
save or run files during a download or installation,
always specify save.

I downloaded some products
manually from the Dassault
Systèmes SOLIDWORKS
Corporation Web site. Can
the Installation Manager
install these?
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AnswerQuestion

Yes. To do so, download to a network share. Each client
can then run SOLIDWORKS Installation Manager from the
share to install.

No further downloads will be required unless a user selects
some items to install that were not selected during the
initial download or if a computer that uses this download
to install has a different set of prerequisites than the
computer to which you downloaded the files.

If you are downloading on behalf of others but are not
installing, select the Download Only option when
installing. This option will allow you to select products
regardless of what may be installed on your system.
However, this option cannot be used to download patches
or to create administrative images.

Can the files I download be
shared by other users?

You will be informed when a new version is available in
the following cases:

• If you run Check for Updates ( Start > All Programs
> SOLIDWORKS Installation Manager > Check For
Updates)

• If you have enabled SOLIDWORKS Background
Downloader.

• If you select an installed version of SOLIDWORKS in
Windows Add/Remove Programs and click Change

• If you run an older version of the Installation Manager
(sldIM.exe) from a download folder

In these cases, you may select to download the newer
version. SOLIDWORKS Installation Manager will download
and run the newer version of itself, and not any installation
files. After the newer version of SOLIDWORKS Installation
Manager runs, you may select a set of installation actions.
SOLIDWORKS Installation Manager will then determine
which installation files are needed (and not downloaded
previously) and will offer to download those files.

How do I know when a new
version of SOLIDWORKS
products becomes available?

Each version of SOLIDWORKS Installation Manager is
designed to install only a specific version of SOLIDWORKS
products. If you want to install a different service pack,
you need to run that version of SOLIDWORKS Installation
Manager. To find the latest version available, see the
preceding item.

Why does SOLIDWORKS
Installation Manager not let
me select a different service
pack of a product to install?
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AnswerQuestion

If proxy server restrictions prevent applications from
downloading files, SOLIDWORKS Installation Manager
cannot download files automatically.

You can download files manually and then install them
using SOLIDWORKS Installation Manager. Select the option
in SOLIDWORKS Installation Manager to download
individual files (for example, Conduct manual download
on the Download Options page). Based on your product
selections and system requirements, a web page appears
in a separate window containing links to download all
required files manually. These links are identical to those
provided by the SOLIDWORKS Customer Portal, but you
do not need to search for the files.

Why is SOLIDWORKS
Installation Manager
prevented from downloading
files?

Check For Updates only tells you whether you have
installed (or are running) the latest version of
SOLIDWORKS Installation Manager.

If you want to update all products to the latest version that
is installed, in Add/Remove Programs, select the latest
installed version of SOLIDWORKS and click Change.

Not all of my SOLIDWORKS
products are updated to the
latest service pack. Why
does Check For Updates tell
me I have the latest version?

Yes, but installations may fail unless you copy the entire
contents of each DVD released for that platform.
SOLIDWORKS Installation Manager looks for the files
swdata*.id to determine the version. If these files are not
present, it will fail to recognize any of the installation files
that you copied and will require that they be downloaded.

Can I copy a DVD to a
download folder?
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Troubleshooting SolidNetWork Licenses
If the SolidNetWork License Manager installation fails, check for these possible
explanations.

Accessing the SolidNetWork License log files
When a license error occurs, the answer often appears in the SNL_Manager_install_dir\
lmgrd.log file.

Could not obtain a license for SOLIDWORKS. Cannot
connect to license server.
Typically, this problem is caused by port settings.

• Port settings between the SolidNetWork license manager and the license client might
not match.

• Additional port settings for multiple versions of SolidNetWork license managers might
not have been specified.

• Check that the client machine can accurately resolve and route to the server, given
the server name. Also, check that the server can accurately resolve and route to the
client, given the client machine name.

For details about port settings for SolidNetWork license managers and clients, see Using
SolidNetWork Licenses with Firewalls.

Troubleshooting Upgrades
If you encounter problems while upgrading to a new SOLIDWORKS release, check for
these possible explanations.

Upgrading from a Source That Has Moved
When SOLIDWORKS is installed, SOLIDWORKS Installation Manager remembers the
location of the installation sources (disk media, disk image on a network, etc.). It expects
the sources to be available at the same location when updating.

If the source moves or is deleted, or if the source media changes, SOLIDWORKS
Installation Manager produces an error message. However, you can continue the upgrade
by browsing to another location as long as it contains all the same file and folder structure.
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Validating Your Graphics CardWhen Installing or Upgrading
When you finish installing or upgrading SOLIDWORKS on your machine, you should run
SOLIDWORKS Rx to ensure that your machine is running a supported graphics card and
graphics card driver.

To validate a graphics card and driver:

1. When the Installation Manager completes installing and displays the Finish page,
under Check Your System, click Run System Diagnostics.

SOLIDWORKS Rx launches and runs diagnostics.

2. SOLIDWORKS Rx confirms if the graphics card and graphics card driver are supported.
If the graphics card is supported but the driver is not, a status message may provide
a link to a supported driver.

Every tenth time you start SOLIDWORKS, a Check Your System message appears and
recommends that you run system diagnostics again. To suppress these notifications,
right-click SOLIDWORKS Resource Monitor in the Windows notification area and click
Turn Off Notifications.

You can validate a graphics card and driver at any time by right-clicking SOLIDWORKS
Resource Monitor in the Windows notification area. The shortcut menu also lets you:

• Display Help for the SOLIDWORKS Resource Monitor
• Run System Diagnostics
• Update Graphics Drivers
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9
SOLIDWORKS InstallationManager
Application Help
You can run SOLIDWORKS Installation Manager:

• From a SOLIDWORKS DVD or a shared source or download folder (when installing a new
version)

• From the Control Panel Add or Remove Programs page (when modifying or removing an
existing version)

• Through a scheduled or manual update check (when detecting, downloading, and installing
new release versions)

Each version of SOLIDWORKS has a version of SOLIDWORKS Installation Manager specific to
that SOLIDWORKS version.

For versions prior to SOLIDWORKS 2008, use SOLIDWORKS 2007 Installation Manager or
download product versions manually from the SOLIDWORKS Support Web site.

If you are running Windows 8, refer to Tips for Using SOLIDWORKS with Microsoft Windows
8 for tasks such as accessing Start or the Control Panel. These steps may vary depending
on how Windows 8 is configured on your system. Consult Microsoft Windows documentation
for additional instructions and options, especially for systems later than Windows 8.

This chapter includes the following topics:

• SOLIDWORKS Background Downloader
• Check for Updates Results
• Administrative Image Location
• Download Options
• Download Options for SOLIDWORKS Installation Manager Files
• Download Product Installation Files
• Download Progress
• Download Results
• Installation Errors/Installation Cancelled
• Installation Is Complete
• Installation Location
• Upgrade Options
• Installation Progress
• Installation Type
• Installing and Managing Multiple Computers
• Manual Download
• Newer Version Available
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• No New Versions Available
• Processes Detected
• Product Selection
• Products to Download
• Products to Repair
• Serial Numbers
• Server Installation
• SolidNetWork License Manager
• Summary
• System Check Warnings
• Hole Wizard/Toolbox Options
• Uninstall Products
• Workgroup PDM Server Options

SOLIDWORKS Background Downloader
SOLIDWORKS Background Downloader performs automated file downloads (for example,
when a new Service Pack release is found) using background processes, enabling you to
continue other work while downloading. When the download completes, you are asked
whether you want to install now, postpone the download, or remove the download.

Background Downloader is enabled by default when you install SOLIDWORKS.

When Installation Manager is running, whether for an installation or download operation,
Background Downloader is paused. For example, it will pause any running downloads,
not allow any new downloads to start, and will not allow you to change the download
folder specification.

You can disable Background Downloader during installation by changing the Download
Options on the Summary page. (Clear the Do you want to use the Background
Downloader? option.)

When enabled, this icon appears in the Windows system tray in the toolbar:

Clicking this icon enables these operations:

• Help with Background Downloader
• Pause Download
• Resume Download
• Cancel Download
• Installation Options
• Change Download Location
• Check for Updates
• Automatically Check for Updates
• Automatically Download Updates
• Disable Background Downloader

Help with Background Downloader

Open this help topic for Background Downloader in SOLIDWORKS Installation Guide.
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Pause/Resume Download

If a download is running in the background, click Pause Download to pause that
download, with the ability to resume later by clicking Resume Download.

Cancel Download

If a download is running, stop that download and delete any files Background Downloader
has already downloaded.

You cannot resume a canceled download.

Installation Options

When a download is completed, you can choose from the following options:

• Install now: Install the downloaded files.
• Remind me later: Do not install the downloaded files, but set up a message to remind
you later.

• Delete this download: Do not install the downloaded files, and delete them. (This is
useful if you have decided you no longer want to install the downloaded files.)

Change Download Location

Change the location where Background Downloader downloads files.

This option is not available if a download is either running or paused.

Check for Updates

Run the Check for Updates feature of SOLIDWORKS Installation Manager.

Automatically Check for Updates

Periodically run Check for Updates, notifying you when updates are available for
download.

Automatically Download Updates

Periodically run Check for Updates, downloading updates as they become available.

Disabling and Re-Enabling SOLIDWORKS Background Downloader

You can disable Background Downloader by clicking the icon and then selecting Disable
Background Downloading.

To re-enable Background Downloader, click Start > All Programs > SOLIDWORKS
Installation Manager > SOLIDWORKS Background Downloader.

Check for Updates Results
Check for Updates looks for later versions of SOLIDWORKS.

You can run Check for Updates manually:
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• In Windows, click Start > Programs > SOLIDWORKS Installation Manager >
Check for Updates

• In SOLIDWORKS, click Help > Check for Updates.

Check for Updates is not available on clients installed from administrative images.

Newer Version Available

SOLIDWORKS Installation Manager has detected a newer version of SOLIDWORKS
products. You can update to a newer version by selecting the SOLIDWORKS Installation
Manager for that version.

This newer version can download installation files based on the products you specify in
the installation. You can share the downloaded files with other users who install using
SOLIDWORKS Installation Manager.

These downloads are only for use by SOLIDWORKS Installation Manager.

These options are available:

• If there are multiple versions available, you can select a version from the list.
• For details about this version, click Check to see what this upgrade includes.

Clicking Next obtains and runs the selected version of SOLIDWORKS Installation
Manager.

No New Downloads Available/Unable to Check for New Versions

SOLIDWORKS Installation Manager has not found a newer version of SOLIDWORKS
products, either because you are installing the latest version available or because it could
not connect to the SOLIDWORKS site to check.

Administrative Image Location
Specify the installation location of the administrative image.

When creating an administrative image, these options apply:

This is the directory location in which SOLIDWORKS Installation
Manager will create the new image.

New image location

This location cannot contain an existing administrative image.
The administrative image must be in a folder that can be
shared for client deployment.

This is the additional space required for the administrative
image.

Estimated space
required for image
creation

Verify that the disk to which you are installing has sufficient
free space to support the image requirements.
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This is the directory location from which you are installing
SOLIDWORKS products.

This option appears only if the Install Only option is
specified. For details, see Download Options on page 113.

Create image from

Download Options
Specify details for completing the download operation, such as the location of the
downloaded files, how to download the files, and whether to install the downloaded files.

SOLIDWORKS Installation Manager supports electronic software distribution (ESD). If
you are not installing from a SOLIDWORKS DVD, you are prompted to specify the source
for the SOLIDWORKS products you are installing.

For answers to questions about the download folder, see SOLIDWORKS Installation
Manager Download Folder on page 104.

What do you want to do?

Choose one of the following:

After the download completes, SOLIDWORKS Installation Manager
runs an installation using the downloaded files.

Download and
install/Download
and create image
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SOLIDWORKS Installation Manager does not run an installation
after the download completes.

Typically, you would specify this option if you are downloading the
files to configure an installation file set to share among multiple
computers.

If you specify this option, you are then asked to choose between
two sets of files to download:

• Files for THIS computer: The download will contain only those
files that are missing from the installation file set currently on
this computer.

This should be a smaller download because it contains:

• Only files for products selected on the Product Selection page
• Only the prerequisite files that are required for your computer
but not yet installed

However, if you try to use this downloaded file set on another
computer to perform an installation, some files could be missing
(because the installation file set on the other computer might be
different from this one). You can use these download files to
install on another computer, but when the installation runs you
may have to download additional files to complete the installation
file set on that computer.

• Files to share with ANY computer: The download will contain
the complete installation file set that can be used to install this
version on any computer.

This will be the larger download because it contains the complete
file set that you can use to install this version of any product on
any computer.

If you specified a limited set of products to download, this option
ignores that specification and downloads all products contained
in the product release.

The download will contain all files required to create an
administrative image, not just those files required to perform an
individual installation.

Download only.
You can download
once and then
share
downloaded files
with multiple
computers.
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SOLIDWORKS Installation Manager does not download any files,
but uses the files in the selected directory.

Click Browse to navigate to a different location. For example, you
can browse to an installation DVD or a download folder, provided
that location contains all the required files.

If you receive an error message that the folder is incomplete, and
you were expecting all installation files to be present at that location,
possible explanations include:

• You selected a component for installation that had not been
downloaded previously or it was selected by default.

• The files were downloaded on another computer with a different
set of system requirements.

• You previously performed a client installation and now are creating
an administrative image, which requires a larger file set.

You can either browse to a folder containing all the files (for
example, a DVD) or select one of the download options.

Install
only/Create
image only. I
already have all
the installation
files needed.

Where do you want to download the required files?

This is the download folder location.

In some cases, this option might be visible but disabled. For example, if Install only is
specified, SOLIDWORKS Installation Manager will install any downloaded files from the
directory specified for that option, rather than using a separate download folder.

Whether you are downloading these files or accessing them from your own location,
all files must be downloaded to the same download folder.

Estimated download size

The estimated download disk space requirements are based on the complete component
listing chosen, regardless of whether this is a new download or you are resuming a
download from a previous session.

For example, if you are resuming a previous download SOLIDWORKS Installation Manager
processes only those files that have not already been downloaded. The download time
could be less than the estimate.

If a file completed downloading in the previous download, its size is not included in this
estimate. Therefore, the estimate might be higher than the actual download size.

How do you want to download?

There are two options:
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In some cases, a proxy server might prohibit automatic downloads
from SOLIDWORKS Installation Manager.

Conduct manual
download

By selecting this option, you can download the files manually
through a Web page and then proceed within SOLIDWORKS
Installation Manager to complete the installation operations. This
Web page is customized by SOLIDWORKS Installation Manager to
download only the files required to complete the installation.

The downloader uses an algorithm to increase the speed of the
download by increasing the network bandwidth used during the
download.

In some cases, this can disturb network performance. If you have
trouble downloading, this option might not be supported by the
proxy server. Try clearing the option and attempting the download
again. For details, check with your network administrator.

This option applies only to automatic downloads. It has no impact
on manual downloads.

Speed up
downloads by
using more
network
bandwidth

Using SOLIDWORKS Background Downloader

You can use SOLIDWORKS Background Downloader to complete this download operation
or to download future SOLIDWORKS Service Pack releases as they become available.

Solidworks Background Downloader can automatically detect and download new Service
Pack updates in the background, notifying you when downloading is complete and the
files are ready for installation. For details, see SOLIDWORKS Background Downloader
on page 110.

Download Options for SOLIDWORKS Installation Manager
Files

You have chosen to download a later version of SOLIDWORKS Installation Manager. Use
this screen to specify where and how it is downloaded.

For answers to questions about the download folder, see SOLIDWORKS Installation
Manager Download Folder on page 104.

This screen appears only if there is a problem with the default download folder (for
example, if write access or network access is not available). Typically, you can just specify
an alternate download directory to proceed.

Download Directory

Browse to the destination for SOLIDWORKS Installation Manager files.

The size of the download and the amount of space needed is shown. The amount of space
needed includes extra space required to unzip certain downloads and is larger than the
actual download size.
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Use Download Acceleration

If you choose this option, the downloader uses an algorithm to increase the speed of the
download.

Download acceleration increases bandwidth and can disturb network performance.
Check with your network administrator before enabling download acceleration.

If download acceleration is not supported by the proxy server, this option is automatically
disabled.

Download Product Installation Files
Specify where and how to download missing files for the specified product.

SOLIDWORKS Installation Manager downloads, verifies, and extracts all files in parallel
during the download process.

Cancelling out of this screen cancels the rest of the installation sequence.

For the consequences of cancellation and instructions on completing interrupted
installations, see Installation Errors.

Download Directory

Browse to the destination for the downloaded files.

The download size and the required space is shown. The required space includes any
extra space needed to unzip certain downloads and is larger than the actual download
size.

For answers to questions about the download folder, see SOLIDWORKS Installation
Manager Download Folder.

SOLIDWORKS Installation Manager Download Folder

Download Options

The downloader uses an algorithm to increase the speed of the
download by increasing the network bandwidth used during
the download.

In some cases, this can disturb network performance. If you
have trouble downloading, this option might not be supported
by the proxy server. Try clearing the option and attempting
the download again. For details, check with your network
administrator.

Speed up downloads
by using more
network bandwidth

Download acceleration increases bandwidth and can disturb network performance.
Check with your network administrator before enabling download acceleration.

If download acceleration is not supported by the proxy server, this option might be
automatically disabled.
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Download Progress
SOLIDWORKS Installation Manager downloads, verifies, and extracts all files in parallel
during this process.

To cancel the download after it has begun, click Cancel.

If you cancel the download or the download fails, a Download Canceled or Download
Problem screen indicates which downloads were not completed and lets you resume the
download or close the application.

For answers to questions about the download folder, see SOLIDWORKS Installation
Manager Download Folder on page 104.

Download Results
Indicates whether the download completed successfully, failed during operation, or was
cancelled.

Download Problem/Download Cancelled

If you see Download Problem, SOLIDWORKS Installation Manager encountered problems
that prevented the download from completing.

If you see Download Cancelled, you cancelled the download before it could complete.

To proceed:

To resume the automatic download from when you cancelled,
select this option and click Retry Download or Resume
Download.

Retry/Resume
automatic downloads

In some cases, a proxy server might prohibit automatic
downloads from SOLIDWORKS Installation Manager.

Download files
individually in a Web
browser

By selecting this option, you can download the files manually
through a Web page and then proceed within SOLIDWORKS
Installation Manager to complete the installation operations.
This Web page is customized by SOLIDWORKS Installation
Manager to download only the files required to complete the
installation.

Download Complete

The Download Complete screen appears when the download completes if you specified
the Download Only option.

Click Finish to exit SOLIDWORKS Installation Manager.

Do not attempt to install any of these products manually. Always use
SOLIDWORKS Installation Manager to install downloaded files.
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Installation Errors/Installation Cancelled
The installation has encountered an error or was cancelled.

If an error or cancellation occurs:

• Products that installed before the error or cancellation remain on the computer.
• The product that was being installed at the time of the cancellation is rolled back, if
possible, so that there are no partial installations.

• Remaining products are not installed or uninstalled. A list is provided under Not Yet
Attempted.

To resume installing or uninstalling these products, click the link provided.

SOLIDWORKS Installation Manager first installs any prerequisites that are not installed
on the computer, such as .NET framework.

Recovering from a Failed or Cancelled Installation
If an error or cancellation occurs during installation, you can recover from that point by
re-running the installation.

1. Record the error message and product code for the installation that failed, as shown
on the Installation Errors or Installation Cancelled screen.

If you are prompted for a source file and you are not modifying an existing
SOLIDWORKS installation, the installation or computer may be corrupt. Contact
your SOLIDWORKS reseller.

2. Reboot the computer.
3. To ensure that no SOLIDWORKS products are running, in Windows, press Ctr+Alt+Del

to open the Task Manager.
4. On the Processes tab, if any of the following processes appear under Image Name,

select them and click End Process.
• SLDWORKS.exe
• EModelViewer.exe
• PDMworks.exe
• pdmwVault.exe
• SWViewer.exe
• solidworksexplorer.exe
• swlmwiz.exe
• photoview360.exe
• SWBoengine.exe
• SWVBAServer.exe
• Sldshellextserver.exe

5. If the application is already installed and you were trying to modify or remove it, try
to repair the installation. For details, see Repairing an Installation.

6. In Windows 7 or later, click Start > Control Panel > Programs and Features. For
earlier versions of Windows, click Start > Control Panel > Add or Remove
Programs.
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7. Select the version of SOLIDWORKS that failed.

If there is no entry for the SOLIDWORKS version you are trying to install, repeat
the installation process.

8. Do one of the following:

• To retry, click Change and select all products that failed to install or were skipped
during the installation.

• To skip the failed installation, click Change and select all products that were
skipped during the installation. Clear the product that failed to install.

• To abandon the installation, click Remove and select any products that were
installed.

This will not restore the previous version of any products you are upgrading.

Repairing an Installation
If you encounter problems with an installed SOLIDWORKS product, you can use the
SOLIDWORKS Installation Manager to repair the installation.

However, to repair an installation, your machine must have all the source files from the
previous installation and any service packs that were applied, in the location where they
were originally installed.

You can repair an individual installation. You cannot repair an administrative image;
you must uninstall and then reinstall the administrative image.

1. In Windows 7 or later, click Start > Control Panel > Programs > Programs and
Features.

2. Select the SOLIDWORKS version you wish to repair and click Change.
3. On the Welcome to SOLIDWORKS Installation Manager screen, click Repair the

individual installation (on this computer).
4. On the Products to Repair screen, select the product to repair.
5. Clear the rest of the products on the screen.
6. Click Repair.

Contacting the SOLIDWORKS Reseller
If modifying or repairing the installation fails, contact your local SOLIDWORKS reseller
with the information gathered from this screen. You might also be asked to provide a zip
file of SOLIDWORKS Installation Manager log files.

1. Locate the log files:

• For Windows 7 or later:
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C:\Users\username\AppData\Roaming\SOLIDWORKS\Installation Logs\
installed_version\

If you cannot find the folder, it might be hidden. In Windows Explorer, click Tools
> Folder Options. On the View tab, under Advanced Settings, select Show
hidden files and folders for Hidden files and folders.

2. Zip the entire contents of this folder, including sub-folders.

Installation Is Complete
SOLIDWORKS Installation Manager has completed its processing.

One or more of these options may be displayed.

What's New

For individual installations, when you finish the installation process, a document describing
new functionality in SOLIDWORKS and its add-in products appears.

For administrative image installations, the document appears on client computers when
they complete their installations.

Survey

Give us your opinions about the installation process by answering a short survey.

Join the SOLIDWORKS Customer Experience Improvement Program

Performance information is sent to SOLIDWORKS Corporation to help improve the product.
The process is transparent and confidential. Select one of the following:

• Yes, I want to join
• No, thank you
• Remind me later
For further information, see the Customer Experience Improvement Program Web
site.

Administrative Image Creation Is Complete

When you finish creating the administrative image, you can click Customize Image to
run the Administrative Image Option Editor to customize the image.

Click Show me how to install this image on a client. to show instructions on using
the Option Editor.

For details about configuring an administrative image using the Option Editor, see
Administrative Image Option Editor.

Click Customize Image to start the Administrative Image Option Editor to customize
the option settings for this administrative image.

You can start the Option Editor later by double-clicking sldAdminOptionEditor.exe
in the Administrative Image installation directory.
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Checking for Updates to SOLIDWORKS
You can use SOLIDWORKS Installation Manager to check for updates manually or to
configure automatic periodic checking for updates.

1. Start SOLIDWORKS Installation Manager by doing one of the following:

• In the SOLIDWORKS application, click Help > Check for Updates.
• In Windows, click Start > Programs > SOLIDWORKS Installation Manager
> Check for Updates.

SOLIDWORKS Installation Manager tells you whether any updates are currently
available.

2. If updates are available, choose whether to download and install them.
3. To enable automatic periodic checks for updates, when SOLIDWORKS Installation

Manager completes its processing select Check for Updates every __ days and
specify the frequency of checks.

SOLIDWORKS Customer Experience Improvement
Program
When installing SOLIDWORKS, you can specify that performance information is sent to
SOLIDWORKS Corporation to help improve the product.

SOLIDWORKS uses this information to determine trends concerning product usage and
quality. Our goal is to deliver the highest quality product and the performance logs are
a useful tool in this process.

The process is transparent. All information contained within the log files is treated
confidentially. It is not used for any other purpose and no one will contact you.

For further information, see the Customer Experience Improvement Program Web
site.

Installation Location
Specify SOLIDWORKS installation locations.

For installations except administrative image creation, these options apply:

This is the directory location to which you are installing
SOLIDWORKS.

When upgrading or modifying an installation, all files must be
installed to the existing location for that installation. In this
case, you cannot change the location of the existing
SOLIDWORKS installation.

Install selected
products to

This is the additional space required for the products selected
for installation or modification.

Estimated space
required for
installation

Verify that the disk to which you are installing has sufficient free
space to support the installation requirements.
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This is the directory location from which you are installing
SOLIDWORKS.

This option appears only if the Install Only option is specified.
For details, see Download Options.

Install from

Consult your system administrator before changing either SOLIDWORKS
installation location.

Administrative Image Locations

When creating an administrative image, these options apply:

This is the directory location in which SOLIDWORKS Installation
Manager will create the new image.

New image location

This location cannot contain an existing administrative image.

This is the additional space required for the administrative
image.

Estimated space
required for image
creation

Verify that the disk to which you are installing has sufficient
free space to support the image requirements.

This is the directory location from which you are installing
SOLIDWORKS products.

This option appears only if the Install Only option is
specified. For details, see Download Options.

Create image from

When upgrading an existing administrative image, SOLIDWORKS
Installation Manager creates a new image based on the settings
for that existing image. This existing image is not modified.
This shows the location of the original image you specified on
the Welcome screen.

Existing image
location

Avoid Using Version-Specific Directory Paths

If you specify a version number in an installation directory location (for example, C:\
Program Files\SOLIDWORKS Corp\SOLIDWORKS 2015\), and then upgrade that installation
to SOLIDWORKS 2016, you will have a SOLIDWORKS 2016 installation directory that is
labeled SOLIDWORKS 2015.
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Upgrade Options
One or more older major versions of SOLIDWORKS are currently installed on this computer.
Choose whether to upgrade the latest existing version to the new version or to create a
new installation for the new version.

This choice appears only if no previous version of this major release is installed on this
computer. If a previous version of this major release is installed, SOLIDWORKS
Installation Manager always updates that installation.

(Starting in SOLIDWORKS 2010, parallel installations of multiple Service Pack versions
of the same major release are no longer supported.)

When upgrading:

• All specified products are upgraded.
• All installed products are selected by default.
• If you deselect a product, that product is not upgraded.

If you deselect a product component, you are not specifying that SOLIDWORKS
Installation Manager remove that component. To remove a product component, use
Add/Remove Programs. For details, see Removing an Installation.

Select the appropriate option and click Next to continue.

Create a new installation of SOLIDWORKS version.

Selecting this option preserves the older major version installation in addition to creating
a new installation for this major version.

This can be useful if you want to access the older version of SOLIDWORKS even after
the newer version is installed. For example, if you are sharing files with other users
who are still running the older version, you can avoid version incompatibility with files
saved using the newer version.

Upgrade SOLIDWORKS previous_major_version to SOLIDWORKS
current_major_version.

Selecting this option upgrades the older version installation to the newer version.

Once the installation completes, the older SOLIDWORKS version will no longer be
available on this computer.

Installation Progress
This screen shows the progress of the installation.

To cancel the installation after it has begun, click Cancel.

For the consequences of cancellation and instructions on completing interrupted
installations, see Installation Errors.
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Installation Type
Specify the installation operation you would like to run, such as creating a new installation,
modifying or repairing an existing installation, creating an administrative image, installing
administrative server products, or downloading files without installing.

Individual

Install SOLIDWORKS products on this computer.

This option appears only if this version is not currently installed on this computer.

Modify the individual installation

Modify the existing SOLIDWORKS installation on this computer.

This option appears only if this version is currently installed on this computer.

Modifications include:

• Adding or removing SOLIDWORKS product components
• Changing to a different SOLIDWORKS package (for example, SOLIDWORKS Professional,
SOLIDWORKS Premium, and so on)

• Changing the SOLIDWORKS serial number setting

If you already specified a SOLIDWORKS serial number during a prior installation,
SOLIDWORKS Installation Manager might not prompt for it again. To change the
serial number that is assumed by SOLIDWORKS Installation Manager, you must
select this option.

Repair the individual installation

Repair the existing SOLIDWORKS installation on this computer.

This option appears only if this version is currently installed on this computer.

Repair verifies that all the files are present and registered properly and fixes any problems
that are found. Data you have created is not affected.

• To repair a product, ensure that it is selected.
• Clear the check boxes for products you do not want to repair.

You can repair an individual installation. You cannot repair an administrative image
installation; you must reinstall using the administrative image.

Administrative image

Create or update an administrative image on this computer.

You can use an administrative image to install on multiple computers. For details about
installing SOLIDWORKS on multiple clients using administrative images, see Using
Administrative Images.
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When creating or updating administrative images:

• You can use installation settings from an existing image to configure the new or updated
image, or you can use the default SOLIDWORKS installations settings.

• If you are updating an existing image:

• SOLIDWORKS Installation Manager creates a new copy of the image, even if you are
updating. The original image is not modified.

• You can create the updated image using files from the existing image you are
updating. This results in a smaller download.

If you do not specify an image for which a Service Pack release is available to update
the previous image, you cannot take advantage of the smaller download.

Server products

SOLIDWORKS administrative server products include SOLIDWORKS Electrical,
SOLIDWORKS Workgroup PDM Server (Vault), SOLIDWORKS PDM, and SolidNetWork
License Manager.

For SOLIDWORKS Electrical and SOLIDWORKS PDM, you can choose to install the client
and server tools on the same computer or on different computers.

For details about installing these servers, see corresponding topics in the Help.

Download only

Download the installation files for selected SOLIDWORKS products without installing the
products.

This option does not appear if you are installing from DVD.

The content of the downloaded files is the same as the files that are available on the
SOLIDWORKS installation DVDs. Selecting this option downloads the full set of installation
files, regardless of what files might already be installed on your computer.

You can use this method to set up a server from which your users can perform installations.
This is different from creating an administrative image.

Installing the wrong SOLIDWORKS architecture for this computer

If you are attempting to install using the wrong SOLIDWORKS installation media for this
computer architecture (for example, if you are trying to install 64-bit SOLIDWORKS on
a 32-bit computer) this installation panel should indicate this problem.

To continue the installation:

1. Cancel this SOLIDWORKS Installation Manager session.
2. Check the computer architecture and system requirements for this computer.
3. Re-install using the correct SOLIDWORKS installation media for this computer
architecture.
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Installing and Managing Multiple Computers
SOLIDWORKS Installation Manager provides the following tools to install and manage
multiple SOLIDWORKS computers.

SOLIDWORKS Administrative Images

If you are installing SOLIDWORKS on multiple computers, you can create an administrative
image and then deploy the application to other computers.

Workgroup PDM Server

The Workgroup PDM application is project data management software that runs inside
the SOLIDWORKS environment or as a standalone application inside SOLIDWORKS
Explorer. Installing the Workgroup PDM Server creates a Workgroup PDM vault, which is
the database that stores the managed SOLIDWORKS projects.

SOLIDWORKS Workgroup PDM support will end after SOLIDWORKS 2017. Customers
already using SOLIDWORKS Workgroup PDM can continue to install it, but should begin
planning to migrate file vaults to SOLIDWORKS PDM Server.

SOLIDWORKS PDM

SOLIDWORKS PDM is a document management product based on the same client/server
architecture as SOLIDWORKS Enterprise PDM. It is available in two versions: Standard
and Professional. SOLIDWORKS PDM uses a Microsoft SQL Server database to manage
file vaults.

SolidNetWork License Manager

The SolidNetWork License Manager allows the number of users to exceed the number of
licenses by floating the use of licenses. When a client license is not in use, it is available
for another SOLIDWORKS user.

You can also use the SolidNetWork License Manager to distribute licenses for SOLIDWORKS
core add-in products (for example, FeatureWorks).

Manual Download
You have chosen to download files manually (or you might have chosen to download
manually the last time you ran SOLIDWORKS Installation Manager).

Click the link to open an automatically generated Web page that contains a complete list
of the files you need to complete your download.

Youmust download to the folder specified on the Summary page. Installation
cannot begin until all the files are downloaded into that folder.

Once you have completed the manual downloads, click Next to continue.

If you want to download automatically, you can change the option by going back to the
Summary Page and changing Download Options.
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Newer Version Available
The Installation Manager has detected a newer version of SOLIDWORKS products. You
can choose to install the version contained in the original installation DVD or download,
or you can choose to download and install the newer version.

If You Are Installing from a DVD

Under Would you like to use the newer version?, choose one of the following:
• No, continue installing version from this DVD. You can update afterwards with
a smaller download.

Select this option to continue with the installation using the current Installation Manager.

After the installation completes, you can check for and install updates using the
Installation Manager. To check for updates, run Start > SOLIDWORKS Installation
Manager > Check for Updates.

The advantage is that this results in a smaller download. The disadvantages are that
this is a two-step process and the files that you download are version specific (and
cannot be shared by other users using different versions).

• Yes, perform installation using this DVD, then download and update to version.

Select this option to download and run a later version of the Installation Manager to
install SOLIDWORKS products for that version.

If a small Service Pack release is available to update the DVD version, Installation
Manager first will install the original version from the DVD and then apply the Service
Pack update. This results in a smaller download.

You can achieve the same result by selecting the option to continue installing from the
DVD and then applying the update at a later date.

The advantage of this option is that it is a one-step process.

In most cases, installing the full version from the DVD and then using the Installation
Manager to check for and install updates is preferred because it requires smaller
downloads.

If You Are Installing from a Download

Choose one of the following:

• Continue installing version.

Select this option to continue installing the version contained in the initial download.
• Download and install a new version: version

Select this option to download the new version and install that. If there are multiple
new versions available, you can select the version to download and install.

128

SOLIDWORKS Installation Manager Application Help



No New Versions Available
There are no newer versions available for download. Proceed with installing the specified
version.

To proceed with the installation, click Next.

Processes Detected
SOLIDWORKS Installation Manager has detected processes on this computer that might
prevent a successful installation.

• To continue the installation do one of the following:

• Close these processes (for example, using Microsoft Windows Task Manager) and
then press Retry.

• Click Ignore to proceed without closing the processes.

• To stop the installation, press Cancel.

Product Selection
Specify the product components to install, modify, download, or remove.

In the product listing:

• The product listing is the complete listing of products that are available in the package
specified above the product listing.

• To view the projected action for a particular component, click the component name
(but not the check box). The intended installation action appears in the information
field below the product listing.

• You can click the check box next to the product component to change the installation
action for that component. (For example, if you are installing or removing components,
selecting the check box specifies that the component is to be installed or removed and
clearing the check box specifies that the component is not to be installed or removed.)

• If you are performing a Modify installation, an asterisk (*) appears to the left of
components when you make any change in the product selection.

• If a component has optional installation sub-components in it, a + icon appears next
to the component. To see the available sub-components for a component, click the +
icon.

• If a component has been expanded to show optional sub-components, a - icon appears
next to the component. To collapse the sub-component listing, click the - icon.

If you are applying a Service Pack, features of SOLIDWORKS appearing under
SOLIDWORKS (for example, FeatureWorks) cannot be selected. This is because you cannot
add or remove a feature when performing this type of upgrade.

The actions performed by SOLIDWORKS Installation Manager are controlled by a set of
product coexistence rules. For details, see Product Coexistence Rules.
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SOLIDWORKS Installation Manager selects these product components by default:

• If you are performing an upgrade or a Service Pack update, SOLIDWORKS Installation
Manager selects the products currently installed.

• Otherwise, SOLIDWORKS Installation Manager selects all products to which you are
entitled.

To reduce your installation or download time and disk space requirements, expand the
product components and clear the check box for those components you do not need.

If SOLIDWORKS Installation Manager was unable to verify the products to which you
are entitled, you can click Select different packages or products to change the
product package (such as SOLIDWORKS Professional or SOLIDWORKS Premium) listing
to install or modify. SOLIDWORKS Installation Manager lists all SOLIDWORKS products
on your installation media that are compatible with the package you select. You can
select any products you purchased or are entitled to evaluate.

SOLIDWORKS Search

SOLIDWORKS Search provides a powerful full text search of SOLIDWORKS documents,
the Workgroup PDM vault, and 3D ContentCentral. Search displays a preview and the file
location and name.

After the installation, SOLIDWORKS Search indexes SOLIDWORKS documents for faster
searches. Only SOLIDWORKS files are indexed by default.

Installing SOLIDWORKS Search automatically installs Windows Desktop Search if it is
not already installed on your computer.

Language Support

Expand the SOLIDWORKS product and the Languages component to see the languages
you can install.

The Languages specification limits the languages that are installed for the
SOLIDWORKS product only. Other product installations are not affected by this
specification. For example, eDrawings®, SOLIDWORKS Workgroup PDM, SOLIDWORKS
Explorer, and SOLIDWORKS PDM install all languages.

Space Needed

SOLIDWORKS Installation Manager reports either total installation size or total download
size at the bottom of the page.

• If you selected the Download Only option, download size appears. Download size
is the total amount of disk space required for all of the downloaded files (not including
extra space required to unzip the files after the download completes). This figure is an
estimate.
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All files needed for installation are included in the total download size. If some files
already were downloaded into the current download folder, they will not be
downloaded again. As a result, your actual download size might be smaller than the
total download size shown, or you might not need to download any files.

• Otherwise, installation size appears. Installation size is the change in disk space
usage that will occur when you complete this installation. Due to file compression,
these figures are estimates.

If you are upgrading or removing an existing installation, the installation size could be
zero.

The figure shown does not include any space needed to download or extract files if
required for the installation.

If downloads are required and you are downloading to the same drive, the actual
disk space requirements could be significantly greater than the installation size that
appears.

To reduce download or installation time for future modifications, do not delete the
downloaded files after installation. Subsequent updates and patches typically require
access to the last full installation file set.

Products to Download
Select SOLIDWORKS products to download to a specified location.

The products available for download are determined by the serial number you supplied:

• The action to be performed for each component appears to the right of each item.
• If a component has optional installation sub-components in it, a + icon appears next
to the component. To see the available sub-components for a component, click the +
icon.

• If a component has been expanded to show optional sub-components, a - icon appears
next to the component. To collapse the sub-component listing, click the - icon.

• Click the check box to the left of each component to select how it is handled by
SOLIDWORKS Installation Manager.

SOLIDWORKS Installation Manager downloads all product components to which you
are entitled, unless you specify otherwise. To reduce your download time and disk
space requirements, expand the product components and select those components
you do not need.

If SOLIDWORKS Installation Manager was unable to verify the products to which you
are entitled, you can select a SOLIDWORKS package to download. SOLIDWORKS
Installation Manager lists all SOLIDWORKS products that are compatible with the
package you select.

If SOLIDWORKS Installation Manager was unable to verify the products to which you
are entitled, you can click Select different packages or products to change the
product package (such as SOLIDWORKS Professional or SOLIDWORKS Premium) listing
to install or modify. SOLIDWORKS Installation Manager lists all SOLIDWORKS products
on your installation media that are compatible with the package you select. You can
select any products you purchased or are entitled to evaluate.
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Language Support

The Languages specification limits the languages that are installed for the SOLIDWORKS
product only. Other product installations are not affected by this specification. For example,
eDrawings®, SOLIDWORKS Workgroup PDM, and SOLIDWORKS Explorer install all
languages.

Space Needed

Based on the products you select, the space needed to perform the download is shown.
Download size is the total amount of disk space required for all of the downloaded files
(not including extra space required to unzip the files after the download completes). This
figure is an estimate.

To reduce download or installation time for future updates and patches, do not delete
the downloaded files after installation. Subsequent updates and patches typically require
access to the last full installation file set.

Products to Repair
When you specify Repair this installation, this screen displays the SOLIDWORKS
products, with version numbers, that can be repaired by this version of SOLIDWORKS
Installation Manager.

Repair verifies that all the files are present and registered properly and fixes any problems
that are found. Data you have created is not affected.

• To repair a product, ensure that it is selected.
• Clear the check boxes for products you do not want to repair.

Click Repair to begin repairing the selected products.

You can repair an individual installation. You cannot repair an administrative image
installation; you must reinstall the administrative image.

Serial Numbers
Serial numbers, found on the distribution box, associate your computer with the
SOLIDWORKS products you have purchased.

If SOLIDWORKS products are already installed on your computer, their serial numbers
are displayed by default.

• Enter your SOLIDWORKS serial number if it is not already displayed.
• If you have serial numbers for products that are not included with your SOLIDWORKS
license, click the product entry underneath Do You Have Other Serial Numbers?
and then enter the serial number for that product.

If you have an internet connection, the serial numbers you provide will determine the
products to which you are entitled as you continue through the installation process.
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Because there are multiple ways to purchase SOLIDWORKS products, some serial
numbers can cover two or more products. For example, a SOLIDWORKS serial number
might enable you to install SOLIDWORKS Simulation without entering a separate
SOLIDWORKS Simulation serial number. In addition, some products do not require a
serial number. If you have any questions about your serial numbers, contact your VAR.

Server Installation
The server products you are attempting to install are listed, with the results of the
installations.

Server Installation Status

Server product installations are performed by an external installation application. If you
are not currently in that application, you must switch to it to complete the installation.

Click Cancel to stop the server product installations.

Server Installation Complete

The external installation application has completed successfully.

Click Finish or Next.
• If you are installing other administrative products (for example, a SOLIDWORKS
administrative image), that installation continues.

• If the server product installations were the only installation operation, SOLIDWORKS
Installation Manager closes.

Server Installation Cancelled or Failed

If a server product installation failed or was cancelled after it was begun, servers that
were not installed are listed.

Click Close or Next.
• If you specified other administrative product installations, SOLIDWORKS Installation
Manager will resume.

• If the server product installations were the only installation operation, SOLIDWORKS
Installation Manager closes.

SolidNetWork License Manager
Specify installation options for the SolidNetWork License Manager server product.

Serial numbers

Specify SolidNetWork License serial numbers. You can specify multiple serial numbers by
separating them using commas.

SolidNetWork serial numbers are different from SOLIDWORKS serial numbers.
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Installation location

Specify the installation location for the SolidNetWork License Manager.

If you are updating an existing SolidNetWork License Manager, you must install to the
existing installation location.

For more information

For details about installing, configuring, and using SolidNetWork License Manager, see
Administering Licenses Using a SolidNetWork License Manager.

Summary
SOLIDWORKS Installation Manager has all of the information needed to complete the
installation operation.

Click the action Now button to initiate the installation operation
(for example, Install Now, Create Now, Download Now,
Modify Now).

To continue:

Click CHANGE for the section you want to change (for
example, Products, Installation Location, Toolbox Options).

To change
installation settings:

Click Cancel to exit SOLIDWORKS Installation Manager without
changing installation components.To cancel:

Click Back to return to a previous page in SOLIDWORKS
Installation Manager.To revert to a

previous page:

For information about a particular set of installation options (for example, Products,
Installation Location, Toolbox Options, and so on):

1. Click CHANGE next to the section for which you want information.
2. In the detail page that appears, click Help to get information about those installation
option settings.

System Check Warnings
System Check reported issues that could impact how you continue with the installation.
In most cases, you should be able to proceed with SOLIDWORKS Installation Manager.

The warnings you can encounter at this stage are listed below with suggestions about
how to proceed.
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The Installation Manager was not able to check for new
versions because it could not validate your serial number.
If you are connected and entered a valid serial number, this
could indicate a temporary problem on our server. Try again
later.

Serial Number Validation: The Installation Manager could not
validate your serial number to determine which products you
are entitled to install. You will still be able to choose
the products you want to install, but you will not be able
to download any installation files. You will need to provide
a complete set of download source files or a DVD from which
to install.

Resolution:

• Check the internet connection. The serial number check requires a
valid internet connection.

• Check that the serial number you entered is valid for the products
you are trying to install.

• Some installations require that you have a valid subscription in place
at the time the version was released. For details, consult your
SOLIDWORKS reseller.

• In most cases, you can proceed with the installation, provided you
are installing from a DVD or a previously downloaded file set.

Serial
Number
Validation
Problems

Newer Version Available

New Versions Available

A newer version of this product is available for download.

Resolution: When performing a Check for Updates operation, the
installation might prompt you to install a later version that is available
by downloading from SOLIDWORKS. You can continue this operation
using the version you initially specified or you can download this newer
version and continue the operation using that version instead.

Newer
Version
Available

This is the latest version available. Click Next to continue.

No New Downloads Available

Resolution: This message can appear when you are checking for updates
during an installation or modification. It indicates that you are currently
installing (or have installed) the latest version available.

Latest
Version
Available
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Internet Connection: The Installation Manager could not
connect to the SOLIDWORKS server to determine which products
you are entitled to install. You will still be able to choose
the products you want to install, but you will not be able
to download any installation files. You need to provide source
files on DVD or a previously downloaded file set.

Unable to Check for New Versions

The Installation Manager was not able to check for new
versions because it could not connect to the server.

Resolution:

• Check the internet connection.
• You can proceed with the installation, provided you are installing from
a DVD or a previously downloaded file set.

Internet
Connection
Problems

Hole Wizard/Toolbox Options
If SOLIDWORKS Toolbox is installed, SOLIDWORKS includes a standard library of hole
types and hardware.

For details about configuring, extending, and using SOLIDWORKS Toolbox, click Help >
Toolbox Help in SOLIDWORKS.

To view this help, you might have to start the Toolbox add-in, using Tools > Add-Ins.

Before using a SOLIDWORKS Toolbox, make sure it is properly configured according to
your company or group policy. In many cases, a group will configure and maintain a
central Toolbox. Check with the SOLIDWORKS administrator for guidance on how to
specify a Toolbox during SOLIDWORKS installation.

You can change the selected SOLIDWORKS Toolbox after installation. In SOLIDWORKS,
click Tools > Options. On the System Options tab, click Hole Wizard/Toolbox.

The following sections describe all options you can encounter on this screen for all
configurations. The actual Toolbox options you see depends on the pre-existing
SOLIDWORKS and Toolbox configurations on this computer and SOLIDWORKS Installation
Manager choices you have specified to this point.

Create a new new-version Toolbox

Create a new version of SOLIDWORKS Toolbox on this computer.

When you create a new version, in the Product Selection screen, expand SOLIDWORKS
> SOLIDWORKS Toolbox and select which standards to support for the Toolbox. All
standards are selected by default.

Any existing Toolboxes on this computer are not modified.

Reference or upgrade an existing Toolbox

Use an existing Toolbox. Click Browse to specify the location of the Toolbox you want
to use with this installation.
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• If the Toolbox is configured for a previous SOLIDWORKS major release version, it is
upgraded to this version. Any customizations made to that Toolbox are preserved in
the upgraded Toolbox.

Upgrading a Toolbox to a new SOLIDWORKS major release version makes
that Toolbox incompatible with computers running prior major release
SOLIDWORKS versions.

• If the Toolbox is configured for this SOLIDWORKS version (as might be the case if you
specify a shared network Toolbox that has already been upgraded), no upgrade to that
Toolbox occurs.

• If you are upgrading a Toolbox in a SOLIDWORKS PDM environment, additional
procedures are required. For details, see Notes About Configuring SOLIDWORKS Toolbox.

This option appears in all installation scenarios except creating an administrative image.

Upgrade a previous-version Toolbox

Copy a Toolbox configured for a previous major release version to a new location and
upgrade that copy to this version.

This option appears if a previous SOLIDWORKS major release version is installed on this
computer, but you have chosen not to upgrade that installation to this release.

The purpose of this option is to upgrade a Toolbox for a previous major release
SOLIDWORKS version that is installed without impacting users that are using the older
version of Toolbox.

If you are upgrading a Toolbox in a SOLIDWORKS PDM environment, additional procedures
are required. For details, see Notes About Configuring SOLIDWORKS Toolbox.

Upgrade this installed previous-version Toolbox

Upgrade this Toolbox to the newer version.

Upgrading a Toolbox to a new SOLIDWORKS major release version makes
that Toolbox incompatible with computers running prior major release
SOLIDWORKS versions.

This option appears if you are upgrading a previous SOLIDWORKS major release version
to this version and a Toolbox configured for that release is found on this computer.

If you are upgrading a Toolbox in a SOLIDWORKS PDM environment, additional procedures
are required. For details, see Notes About Configuring SOLIDWORKS Toolbox.

Use the installed current-version Toolbox

SOLIDWORKS Installation Manager has detected on this computer a Toolbox configured
for this SOLIDWORKS major release version.

If you select this option, SOLIDWORKS will use this Toolbox. No upgrade occurs.

This option appears if a previous SOLIDWORKS major release version is installed on this
computer, but a Toolbox is configured for this version. This might occur if a shared Toolbox
is created on a computer that is still running an older SOLIDWORKS version.
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Specify the Toolbox location for the client computer

Specify a network or directory location as the default Toolbox location when clients install
from an administrative image.

If the location contains a Toolbox configured for a previous SOLIDWORKS major release
version at the time the client installation occurs, SOLIDWORKS Installation Manager
upgrades that Toolbox.

This option appears when you are creating a new administrative image.

Upgrade or use the Toolbox referenced in the existing image for the client
computer

Use the Toolbox location specified in an existing administrative image you are updating.

If the location contains a Toolbox configured for a previous SOLIDWORKS major release
version at the time the client installation occurs, SOLIDWORKS Installation Manager
upgrades that Toolbox.

Select a different Toolbox location for the client computer

Specify a different Toolbox location from that specified in an existing administrative image
you are updating.

If the location contains a Toolbox configured for a previous SOLIDWORKS major release
version at the time the client installation occurs, SOLIDWORKS Installation Manager
upgrades that Toolbox.

Notes About Configuring SOLIDWORKS Toolbox
SOLIDWORKS Toolbox is a powerful and complex feature. This topic summarizes some
concepts to consider before configuring a Toolbox using SOLIDWORKS Installation Manager.

Finding More Information About SOLIDWORKS Toolbox

For details about configuring, extending, and using SOLIDWORKS Toolbox, click Help >
Toolbox Help in SOLIDWORKS.

To view this help, you might have to start the Toolbox add-in, using Tools > Add-Ins.

Using a Shared Toolbox

When you install Toolbox, you can have Toolbox data on the local computer or in a shared
network location. Storing Toolbox data in a network location is recommended. By using
a common location, all SOLIDWORKS users share a consistent set of fastener information.

If this is the first time installing, browse to the new shared location where you would like
to install the Toolbox.
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Upgrading an Existing Toolbox

Upgrading a Toolbox to a new SOLIDWORKS major release version makes that Toolbox
incompatible with computers running prior major release SOLIDWORKS versions.

If other computers remain at that prior major release and continue to require a Toolbox
configured for that release, you should make a copy of that Toolbox and upgrade that
copy. The new SOLIDWORKS installation will upgrade the copy of the Toolbox and the
previous SOLIDWORKS installations will continue using the old Toolbox.

Configuring Toolbox Access

After installation, when you access Toolbox components SOLIDWORKS checks how you
have configured Toolbox and makes suggestions to improve access and performance.

For accessing the shared network Toolbox (recommended), use a UNC path to the server
on which the shared Toolbox was installed. For details, see UNC Format.

An administrator can create a password for Toolbox and set permissions and preferences
for the workgroup. Restricting access to configuration and setting common preferences
ensures consistent Toolbox data.

Upgrading Toolbox in a SOLIDWORKS PDM Environment

When you upgrade the SOLIDWORKS software, Toolbox is upgraded if parts have been
added. If the Toolbox root folder is in a SOLIDWORKS PDM vault, before you start the
SOLIDWORKS upgrade, you must prepare the Toolbox folder.

On the first system to perform the upgrade, you must use Get Latest Version to download
the Toolbox files to the local cache and check out the Toolbox database file. On other
systems that are upgraded, the only requirement is to download the Toolbox files.

Before you upgrade:

• Ensure that there is a full recent back up of the vault database and archive.
• Make sure that the Toolbox parts are not checked out or in use by any currently checked
out assemblies.

To upgrade Toolbox:

1. In Windows Explorer, log in to the vault as a user with full permissions (check out,
check in, add, delete).

2. Right-click the Toolbox folder and click Get Latest Version to copy all Toolbox files
and the toolbox database to the local cache.

If your archive server is remote, this may take several minutes.

3. Check out the Toolbox database file (SWBrowser.mdb) from \Toolbox_folder_name\
lang\your_lang.

4. Run the SOLIDWORKS Installation Manager to perform the upgrade.
5. On the Summary screen, ensure that the Toolbox Options installation location is the
location in the vault.

If it is not, click Change, select Reference or upgrade an existing Toolbox, and
browse to the Toolbox location in the vault.

6. When the upgrade completes, in Windows Explorer, check in the Toolbox folder to add
any new or updated files to the vault so that other users can work with Toolbox.
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7. For upgrades to SOLIDWORKS 2012 or later, navigate to your Toolbox folder in the
vault and ensure that the following are present:

• \Toolbox_folder_name\Updates
• \Toolbox_folder_name\ToolboxStandards.xml
• \Toolbox_folder_name\Browser\ToolboxFiles.index

If they are not, contact your Value Added Reseller.

8. Upgrade the rest of the computers that use SOLIDWORKS PDM integration with Toolbox:

a. In Windows Explorer, log in to the vault as a user with at least read permission to
the Toolbox folder.

b. Right-click the Toolbox folder and click Get Latest Version to copy the Toolbox
files to your local cache.

c. Run the SOLIDWORKS Installation Manager to upgrade.

The installer detects that Toolbox is already upgraded.

For details about Toolbox configuration in SOLIDWORKS PDM, see Configuring Toolbox
in the SOLIDWORKS PDM Administration Tool help.

UNC Format
Uniform (or Universal) Naming Convention format specifies a file name syntax format to
describe a shared file location.

\\server\volume\path

For example:

\\Disk_Server\SOLIDWORKS\AdminImage

Uninstall Products
When you select to Remove or Uninstall programs from the Control Panel, this screen
displays the SOLIDWORKS products (with version numbers) that can be uninstalled by
this version of SOLIDWORKS Installation Manager. You can choose to perform a standard,
custom or complete uninstall.

The standard uninstall removes Program Files and Folders of a SOLIDWORKS product.
By default, all SOLIDWORKS products for the selected release are specified for a standard
uninstall.

A custom uninstall removes one or more of the following items: Program Files and Folders,
registry keys and data folders, such as the SOLIDWORKS Toolbox, and files and folders
from the original download location.

A complete uninstall removes the install directories, registry keys and data folders.

To uninstall a product:

1. On the Uninstall screen, ensure that the product is selected.

If you uninstall all products, the Solidworks Installation Manager is also uninstalled.
2. Clear the products you do not want to remove.

If you retain any product, SOLIDWORKS Installation Manager is not removed.
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3. Choose whether to perform a custom or complete uninstall.

a. Click Change in Advanced Options.

The Advanced Options screen appears. The Program Files and Folders option is
checked.

b. Select one or more options to perform a custom uninstall, or select all options to
perform a complete uninstall.

c. Click Back to Summary.
d. On the Summary screen, expand Advanced Options to display the uninstall method
and entries.

4. Click Remove Items.

When you click Remove Items, SOLIDWORKS Installation Manager starts
removing products immediately.

Workgroup PDM Server Options
Specify installation options for the SOLIDWORKS Workgroup PDM server product.

Installation Location

Specify the installation location for the Workgroup PDM server products.

Products to install

Specify which Workgroup PDM server products to install:

Specify the location for the Workgroup PDM Vault data. A
Workgroup PDM Viewer license must be installed with the vault
to enable the Viewer.

Workgroup PDM Vault

When installing the Workgroup PDM Viewer, you must specify
the name or IP address of the Workgroup PDM Vault computer
that the Viewer will access.

Workgroup PDM
Viewer

A license for Workgroup PDM API is included with the licenses
of SOLIDWORKS clients and Explorer clients. Check-in APIs
require client licenses.

Workgroup PDM API

For more information

For details about installing Workgroup PDM, see SOLIDWORKS Workgroup PDM on
page 65.

For details about using Workgroup PDM, see Workgroup PDM in SOLIDWORKS Help.
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